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CHAPTER

1
About This
E-book

HI there,

Thanks and congratulations for downloading this e-book! We
created this book to gather together all the essential information

related to Mobile Joomla!, as well as some tips and tricks. We hope you
find it valuable and helpful.

We would be delighted to hear your feedback. If you have any sug-
gestions or comments related to this book, please send them to us at
�hello@mobilejoomla.com.

Thank you for supporting Mobile Joomla!

Happy reading,
The Mobile Joomla! Team

PS. You should follow us on �Twitter and � Facebook to hear when we
publish updates to this e-book.
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CHAPTER

2
Introduction

WELCOME! In the following chapters we will dive into the var-
ious sides of Mobile Joomla!.

Mobile Joomla! is the best way to mobilize your Joomla!
site, displaying beautifully on the iPhone, Android, Windows Phone,
Blackberry, Nokia and all other phones. Mobile Joomla! is designed
especially for professional use.

Mobile Joomla! is as simple as it gets. You can get your Joomla! site
“Mobile Ready” within a few seconds. Mobile Joomla! ensures the best
look and results with its state-of-the-art device detection methods and
smart content adaption algorithms to optimize the experience specifically
for each of your visitor’s mobile device.

Mobile Joomla! is much more than just a template switcher. It allows
you to have correctly optimized images for any device, remove HTML
tags that may lead to problems in certain mobile devices, have a special
homepage for mobile users, combine and minify CSS and JavaScript files,
etc. Using the advanced settings, customization options, and extensions,
modules, and plugins, you can prepare your mobile website to display
great on any mobile phone.

Good mobile user experience requires a lot more than just resized and
reorganized website layout. Mobile users expect your website to load
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2.1. Downloading Mobile Joomla!

in no more than 4 seconds, and they want to have easy access to the
information they are looking for without scrolling aimlessly.

With Mobile Joomla! you do not need to worry about usability. Mobile
Joomla! makes sure your mobile site is available and perfectly optimized
for all the devices available. It doesn’t matter if you use a responsive
template – Mobile Joomla! still optimizes your content delivery.

2.1 Downloading Mobile Joomla!
We follow the below steps to download Mobile Joomla!:

• To begin with, download the latest Mobile Joomla! package
from Mobile Joomla! Download (http://www.mobilejoomla.com/
download.html). Save the package on your computer.

• Download the latest Joomla! package from Joomla! Website.
Throughout this manual, we will use Joomla! 3.4 for the sake of
example. Follow official Joomla! documentation to install Joomla!
on your server.

2.2 Installing Mobile Joomla!
You do not need to be a Joomla! guru to install and setup Mobile Joomla!.
Upload, follow instructions, and you have a mobile website.

2.2.1 Requirements

The following system components are needed for running all Mobile
Joomla! features. If your hosting provider does not provide all of these
Mobile Joomla! might not be fully functional or the installation fails.

• Joomla! 1.5+, Joomla! 1.7+, Joomla! 2.5+, or Joomla! 3.0+
• PHP 5.2+.
• At least 32 MB of memory for running PHP scripts (PHP memory

limit).
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2.2. Installing Mobile Joomla!

• PHP gd2 extension (image library for image scaling).
• Possibility to load data over HTTP protocol (allow_url_fopen en-

abled, etc.); it’s required for Mobile Joomla! updating.
• File creation rights on PHP.
• MySQL 5.0+.
• At least 30 MB of database disk space.
• Advanced Mobile Device Database (AMDD) is default MJ device

database used by Mobile – AMDD plugin, and it requires about
5 Mb of space in database. This database is maintained by Mobile
Joomla! Team and includes most popular mobile devices.

Note: If you find that your hosting environment is not suitable for
running Mobile Joomla!, we recommend SiteGround hosting.

2.2.2 Directory Permission

Mobile Joomla! requires following directories to have write access on
your PHP hosting.

/administrator/components
/administrator/language/en-GB
/administrator/modules
/cache
/components
/language/en-GB
/media
/modules
/plugins
/plugins/system
/templates

If you get an error like

11
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JFolder::create:␣Could␣not␣create␣directory
Warning!␣Failed␣to␣move␣file.

during the installation, the write access needs to be set manually.

2.2.3 Installation

We will follow the below steps to install Mobile Joomla!:

• After downloading the package, we need to go to the administration
panel of our Joomla! site.

• Now go to Extensions → Manage.

• We will see the extension manager page on our screen.

• We browse and upload the downloaded Mobile Joomla! package.

• Then click the upload & install button. It will take some time to
install the package. You should see the following screen upon a
successful installation.

12
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• If your installation fails in this point, most likely your hosting
provider is using too old PHP version, does not support all PHP
features or PHP does not have enough system resources to perform
the installation. Some workarounds are suggested below.

2.2.4 Error During Install

To understand possible errors sources, let us go through all the steps of
installation process.

• Step 1. Joomla! unpacks archive to site’s temporary directory.

• Step 2. Joomla! then copies the unpacked files to the directory
administrator/components/com_mobilejoomla and creates cor-
responding settings in the database. Note that both unpacking and
copying take some time, and it may lead to two types of errors:

1) PHP’s timeout;

2) MySQL’s timeout.

In the first case max_execution_time parameter in php.ini should
be increased or Install from Directory method should be used (it
allows skipping the first step).
In the second case, the parameter of MySQL should be increased
(Joomla! 3.x reconnects to the database automatically, and for
Joomla! 1.5 there is a patch on http://remository.com/downloads/
support-files/joomla-1.5/database-interfaces/).
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• Step 3. Mobile Joomla! installer starts to work. At first, it tries to
increase PHP’s timeout and memory limit and prevent Joomla! from
die on errors.

• Step 4. Mobile Joomla! installs required extensions in the following
order:

I. Template Mobile_Basic.

II. Modules: Mobile Menu (mod_mj_menu), Proxy Module
(mod_mj_proxymodule), Proxy Position (mod_mj_proxyposition),
Mobile Switcher (mod_mj_switcher), Mobile Joomla! CPanel Icons
(mod_mj_adminicon, Joomla! 1.5-1.7).

III. System plugin: Mobile Joomla! Plugin (the core of Mobile Joomla!).

IV. Mobile plugins: Quickicon – Mobile Joomla! CPanel Icon, Mobile –
Simple, Mobile – Always, Mobile – Domains, Mobile – AMDD.

2.2.4.1 Install Fails with Blank Screen

In most cases it means that your server is limited in resources and Joomla!
has no time or memory to unpack Mobile Joomla! archive (Step 1 or 2
from the above description). The simplest way to find out the reason of
the error is to set error reporting: Maximum in Server tab of Global Con-
figuration in Joomla!’s backend and then try to reinstall Mobile Joomla!.
In this case, you should get error message instead of a blank page during
install. Further, actions will depend on the message.

If you still get blank page, you should check your error_log file for info
about the error. If your site is located at /some/path/public_html/,
then usually error_log is in:

• /some/path/public_html/ (that is in the root of the site);
• /some/path/public_html/administrator/ (Joomla!’s backend

directory);
• /some/path/ (one level above the site root);
• /some/path/logs/ (in the special log directory).
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In the case of timeout issue the solution is to increase timeout
(max_execution_time parameter in php.ini) or to use Install from Di-
rectory method (unpack Mobile Joomla! to Joomla!’s tmp directory and
do install from the directory).

2.2.4.2 Content is Not Displayed for Mobile Phones

If you try to open the page in a mobile browser (iPhone/others), the
mobile site version does not have content. A possible cause may be that
you are using a low-end/free hosting which inserts ads on the page. These
kinds of hosting plans are not compatible, because they break mobile
HTML code.

2.2.4.3 Gateway Time-out

The gateway did not receive a timely response from the upstream server
or application. It may be because PHP is run in CGI/FastCGI mode with a
very short timeout (it is not related to max_execution_time in php.ini)
that doesn’t allow Mobile Joomla! installer to finish install procedure.
You can ask your hosting provider to increase the timeout limit.

2.3 Updating Mobile Joomla! Basic Version
You can update to a new Mobile Joomla! version from your administrative
panel via Mobile Joomla! Remote Update feature, or by downloading
the new Mobile Joomla! package and installing it manually from the
back-end. Do not forget to back up your website before the update.

Updating Mobile Joomla! keeps all your settings. But all Mobile Joomla!
files (except favicon.ico, css/custom.css, css/custom_preload.txt,
js/custom.js, and js/custom_preload.txt in Mobile_Basic template)
will be overwritten, so be careful if you changed them.
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2.3.1 Updating Mobile Joomla! Pro & Club

The update process is identical to the standard Mobile Joomla! version.
Before updating, please take a backup of your site as a precaution.

2.4 Device Types
Mobile Joomla! divides mobile devices into two groups for better flexibil-
ity in managing features for each type of devices:

• Mobile: all modern phones, smartphones, etc.
• Tablet: all tablet devices (this mode is supported by Mobile Joomla!

Pro).

2.5 Basic Settings & Configurations
We have installed Mobile Joomla! successfully. Now we will see the basic
configuration options of it. We’ll discuss the options step-by-step in below.

The Settings page allows you to tune Mobile Joomla! settings to fit your
needs. Settings are split into several pages: General and Advanced for
settings that are common for all types of devices, pages corresponding
to supported mobile modes (Mobile and Tablet), Plugins and Modules
to disable specific extensions in different modes, and finally, the Preview
page to test devices.

Full information about each setting’s page can be found in corresponding
chapters of this guide.

16
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2.5.1 General Settings

First, let’s click the “General” page. It will display the below options:

Enable Mobile Joomla!
Enable or disable Mobile Joomla!. Internally it just enables and
disables Mobile Joomla! plugin.

Auto update
Mobile Joomla! will be updated automatically. New releases will be
checked once per day and installed in the background.

Templates
Duplicates template settings from corresponding Devices pages.
Selected templates will be displayed for Mobile visitors.

Mobile title
We can overwrite the title of the mobile site here. Just write down
the title in the text box.

Force as homepage
Set this page as a homepage (e.g. index.php?option=com_content&
view=article&id=8&Itemid=1). We choose a menu item from the
select box. This will be displayed as homepage in mobile devices.

Rescale images
Rescale images into optimal size based on device resolution. This
will rescale the image, if the width of the original image is wider
than screen width.

17
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Rescaling quality
We can set the quality of the rescaled JPEG image here. The range
is between 0 and 100.

2.5.2 Advanced Settings

To go to the advanced configuration options, click the Advanced settings
page. This will bring the below options. Let’s go through each of the
options here.

Server Caching
By enabling this option, we use server caching to cache pages for
mobile devices. This improves application performance a lot. Note
that server caching may require much disk space because of each
device type is cached separately.

Device Caching
If we check this option as On, then pages will be cached in mobile
device browsers for 15 minutes. Recommended for rarely updated
websites without frontend authorization.

Gzip Compression
We can compress the output of the pages by enabling the option.

18



2.5. Basic Settings & Configurations

Distribution method
Distribution method of the compressed JS and CSS files to the client
device. Different methods perform better on different server setup.
Direct method distributes them in the standard method of the web-
server (like any other files), but most likely then Gzip compression
and caching may be disabled. Apache mod_rewrite+mod_headers
is the fastest method, but requires Apache with mod_rewrite and
mod_headers modules enabled. Apache mod_rewrite and PHP are
identical from the performance point of view; the only difference
is that Apache mod_rewrite requires Apache, while PHP generates
not-so-beautiful URLs like /media/mj/get.php?abcdef.js instead
of just /media/mj/abcdef.js. Mobile Joomla! attempts to choose
optimal method during installation.

Subdomains for Mobile and Tablet (in Mobile Joomla! Pro)
If we want to use subdomains for the different mobile visitors, then
we will write the corresponding subdomain names in these fields.
See the next section for more on how to set up subdomains.

Remove unsupported tags
With this option selected, we can remove unsupported tags (object,
embed, applet) from our pages in the mobile devices.

Remove comments
Clean up page by removing comments from the HTML code for
faster loading.

Remove spaces
Removes empty spaces from the HTML code for faster loading.

Minify URL
Replaces absolute URLs (http://www.website.com/link) into rela-
tive URLs (/link) to reduce page size. Disable if there is a conflict
with another extension (e.g. which uses JavaScript that requires all
links to have a full domain name).

Force style
We can add width and height to style attribute of the IMG HTML
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element. Useful in the case of conflict with 3rd-party CSS styles for
sizing images.

Wrap wide
Wrap images that are wider than half of the screen into a centered
<span>. This makes a floating (align=right or align=left at-
tribute) image to fill full horizontal size if it’s wider than 50% of
the screen width (otherwise there is a narrow column of text near
the image).

Lazy load
Lazy load images with the Lazy Load XT script. Significantly speeds
up the loading of image and/or video-heavy webpages.

Optimize CSS
Optimizes CSS for better performance. Removes unnecessary white
spaces, unused code, etc.

Optimize JS
Optimizes JavaScript for better performance. Removes unnecessary
white spaces, minifies the code, etc.

Inline limit
Inline limit allows to inline small CSS or JavaScript (up to the
specified limit) into the page directly in order to avoid sending
additional requests to the server (i.e. speeds up loading). 1024
bytes is likely optimal for most cases, allowing inline of small files
while not inlining large ones.

2.5.3 Mobile and Tablet Settings

We go to the Mobile settings page (Tablet settings page has the same set
of settings). This page brings the below screen:
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2.5. Basic Settings & Configurations

All presented settings override global settings in General and Advanced
pages.

2.5.4 Plugins Settings

Some plugins might not be compatible with certain devices. That is why
Mobile Joomla! provides a way to disable plugins for desktop, mobile
devices, and tablets. The only exception is “system”-type plugins: Joomla!
loads and executes them automatically at initialization stage, before
Mobile Joomla! code is executed.

2.5.5 Modules Settings

In a similar way, it’s possible to disable specified modules for desktop,
mobile, and tablet devices.

2.5.6 Testing Preview

With the mobile device simulators included in the Mobile Joomla! backend
you can check how your changes affect your site on the fly! Just click on
the thumbnail image to display your mobile website on given device.

Please note that despite the simulators should be quite accurate, since
they are by definition simulators and not real devices or emulators, there
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may be slight differences between the view of the Online Device Simulator
and the real device.

2.6 Using Subdomains with Mobile Joomla!
Using subdomains (like mobile.yourdomain.com) is one way to indicate
to your users that you have special optimized mobile version of the site.
And you can use name of the subdomain for marketing purposes.

Mobile Joomla! doesn’t create subdomains (that is, it doesn’t change DNS
or web-server settings), but it allows you to use existing, already set up
subdomains for the mobile site.

The first step to make mobile subdomain is to set up subdomain as an
alias to main domain. We recommend to disable Mobile Joomla! by
unpublishing Mobile Joomla! Plugin, and then get your site working via
both the main domain and subdomain (that is, the subdomain displays
identical page as the main domain).

Usually webhosters allow either to make aliases directly (there is a special
field in the main domain settings), or indirectly via possibility to set
DocumentRoot directory for the subdomain to be identical to the main
domain’s DocumentRoot. (Note that in most cases this is done at the time
of first creating the subdomain, and you cannot change it after that).

After the subdomain is set up on your webhost, you can enable Mobile
Joomla! and test this subdomain to see the mobile version.

2.7 Mobile Menus
Mobile menus are Joomla! menus, which are available on the mobile site
only. In this section, we will see how to convert a web-specific menu into
a mobile-friendly menu.
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2.7. Mobile Menus

2.7.1 Creating Mobile Menu

Now we will create a mobile-specific menu. Let’s follow the below steps
to create one such menu.

• Go to Joomla! administration.
• Go to Menu Manager
• Click “New” to create new mobile menu, fill Title and Menu Type

fields (e.g. “Mobile Menu” and “mobilemenu”, correspondingly), and
Save result

• Add menu items to new menu. It’s highly recommended to use
“System Links/Menu Item Alias” item type to populate mobile menu
with aliases to existing (desktop) menu items.

2.7.2 Assigning a Menu to Mobile Site

Here we are going to see how to assign a menu as main menu of the
mobile site. We will go through the below process.

• Go to Extensions → Module Manager.

• Filter by module and choose existing mobile menu module. You can
find them by looking position of mj_panel.

• Then click the Menu module.
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• On right hand, in menu drop down choose Mobile Menu (the menu
you just created).

2.8 Disabling Mobile Joomla!
To disable Mobile Joomla!, set Enabled: No in General Settings page and
then Save settings.

Internally it just unpublishes the Mobile Joomla! Plugin, so that unpub-
lishing of Mobile Joomla! Plugin has the same effect.

Set Enabled: Yes or republish the plugin to start Mobile Joomla! again.

2.9 Uninstalling Mobile Joomla!
To uninstall Mobile Joomla! uninstall the Mobile Joomla! component in
Joomla!’s standard fashion. Note that the Mobile Joomla! settings will be
lost if you uninstall it.

• First, we go to Extensions → Manage.

• Then click the “Manage”. And search for Mobile Joomla!. Then
click “Uninstall”.
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2.10 Asking for Help
We may face problems sometime using with Mobile Joomla!. If you
experience a problem with Mobile Joomla!, you can find a solution in the
following way:

1) First of all, please read our Frequently Asked Questions. They
contain instructions what to do in the most of the common error
situations. Often the case is that your hosting provider does not pro-
vide the necessary quality of PHP hosting to make Mobile Joomla!
run smoothly. In these cases, the instructions hint you what might
be wrong with the hosting.

2) If you can’t find an answer in the FAQ, please search our community
support forums for an answer. Often we have already earlier solved
similar issues that you can learn from.

3) If you still couldn’t find an answer, post a message to our community
support forums. To get help quickly and effectively, your question
must contain enough background and technical details to be an-
swerable.

• The Joomla! version you are using and the Mobile Joomla! version
you are using.

• Your hosting provider’s name.

• Your hosting package’s name.

• Your website’s address (if public).

• Which phones or browsers you have tested. Also, it is good to
provide the exact user agent string using our user agent identifying
service. The user agent tells how Mobile Joomla! sees your browser
or a mobile device. If there are any problems with browsers or
devices they can be tracked down using the user agent string. You
can check your user agent by entering this URL with your mobile
browser: http://www.mobilejoomla.com/uatest.php.
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2.11. Video Tutorials

• It is good to test many browsers or user agents. If you do not have
several devices in your possession, please see the next chapter in
this book for ways to test your site.

• Other details of your hosting environment that you might know:
PHP version, MySQL version, operating system and its version.

• The detailed error messages. You must copy and paste these – the
community members are not mind readers and do not magically
know what happens on your screen.

• Confirmation that you have read frequently asked questions, and
you did not find your question answered there. If you post a ques-
tion to an issue, which has been answered many times before this
might be considered as lazy or rude behavior on your behalf. The
community is eager to help you, but will not work for you for free.

Tip: If you have purchased any Mobile Joomla! premium product, you
can use our Premium email supports.

2.11 Video Tutorials
Mobile Joomla! video tutorial is available at Open Source Training. Big
thanks to Open Source Training providing this material.

2.12 3rd-party Language Packs
For installation of other languages, please see this forum link: http://
www.mobilejoomla.com/forum/12-languages.html

• Russian translation by avtomastersu
• Polish translation by dumes
• Danish translation by gundestrup
• German translation by medico
• Swedish translation by sweup
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2.12. 3rd-party Language Packs

• Portuguese translation by lfsabreu
• French translation by sharky
• Norwegian translation by Skurva.com
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CHAPTER

3
Testing Your
Mobile Site

WE have seen the basic configuration and setup procedure of
Mobile Joomla!. After the setup, it is good to test with many
mobile browsers that your mobile site works correctly. In this

chapter, we are going to see how we can test our mobile website to make
sure it is working properly.

How to test mobile websites on your desktop with different mobile devices
is a question we get quite often. We have collected here some of the best
free and paid tools you can use to test your mobile sites on your desktop
on various devices, without having to actually go and loan or purchase
the devices. Just keep in mind that it’s always best to do sanity checks on
the actual devices as well, if you have access to them somehow.

3.1 Important Note About Latency
Don’t forget to play with the connection speed, which many of the tools
allow you to change. It makes a HUGE difference to the website loading
time if the mobile visitor is using a 3G or even 4G network. The total
“network overhead” time for mobile page loading on 3G is over 50%!
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3.2. Quick Tests with Mobile Joomla!

That’s spent without regard to your web server’s or the client device’s
performance, just due to the mobile network latency. You won’t even
realize that if you only do your testing on fast DSL.

3.2 Quick Tests with Mobile Joomla!
The simplest ways to test the mobile version of your site when you have
Mobile Joomla! installed are:

1) to visit your mobile subdomain (if you are using one).

2) to switch to a mobile site by enabling the “Mobile Switcher” module,
which allows you to choose between web version and mobile version
manually.

3) to use our Mobile – Always plugin.

4) to add ?device=<mode> parameter to the URL like the following
way. We will see device specific options here:

• http://www.yoursite.com/?device=mobile to test mobile version.
• http://www.yoursite.com/?device=tablet to test tablet version.
• http://www.yoursite.com/?device=desktop to switch back to desk-

top version.

29



3.3. Background Preparations – Understanding Your Mobile Visitors

3.3 Background Preparations – Understanding Your
Mobile Visitors
There’s such a huge amount of devices out in the market that you need to
focus your efforts. It’s simply not productive to try to test with hundreds
of different devices and browsers.

It would be best to start with analyzing your target audience, i.e. your
website visitors. What are the main user groups in terms of demographics?
What devices can you assume they use? Cheaper Android phones, or
iPhones? Windows Phones? From which countries does the majority of
your traffic come from?

A good tool for checking high-level country-level stats is Statcounter’s
service, here’s for example the graph for mobile and tablet OS market
shares for the US:

You can and should check your existing traffic from Google Analytics.
Go to your Reporting view, and select Audience → Mobile → Devices, and
you will what your current visitors use. You probably will see a lot of
variations of the same devices and close cousins like Samsung GT-I9295
Galaxy S4 Active, Samsung GT-I9195L Galaxy S4 Mini, Samsung GT-I9195
Galaxy S4 Mini, etc.
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3.3. Background Preparations – Understanding Your Mobile Visitors

Realistically, you can check your Top 10 devices in more detail, and then
combine different variants and include 10-20 more device profiles that
you will check in less detail, to cover e.g. 80-90% of your mobile traffic.
Naturally the scope depends on how much traffic the site gets.

So, with your top 10-30 devices identified, let’s review some of the best
ways to test your mobile websites:

3.3.1 Test on the Real Mobile Device

Yes, we promised to cover the various alternative tools, but let’s just get
this out of the way first.

Naturally, it is always best to test your website using the actual devices
so that you can actually see what’s really going on with your website.
This way you are also able to see any possible bugs in the device software
(firmware) which might cause (not-so-)funny outcomes. Also, if you use
local caching, you may find out that it doesn’t work the way intended if
you haven’t taken into account the mobile device’s much smaller cache
space available which fills up fast.

The user experience contains many factors like variable network condi-
tions, pixel densities, the relative size of tap targets, and real page load
times. In a perfect world, every website would be tested on every major
mobile device that it might be viewed on.

3.3.2 Online Emulators and Simulators

What’s the difference between a simulator and an emulator? In many
cases, the terms are used interchangeably. Both let you run the mobile
device software in the desktop or browser environment.

Typically, emulator specifically means that it works by duplicating every
aspect of the original device’s behavior down to the hardware. So it tries
to mimic the real device use as closely as possible.
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3.3. Background Preparations – Understanding Your Mobile Visitors

A simulator, on the other hand, sets up a similar environment to the
original real device, but it doesn’t attempt to simulate the actual real
hardware. This may affect the results. Practically when we’re talking
about testing mobile websites, this doesn’t necessarily make that much
difference (but it might). Most of the (most convenient) tools available
are simulators, while emulators typically are distributed as downloadable
applications along with possible IDEs more targeted for app development.

3.3.2.1 Important: User Agent Recognition

One important concept in the mobile world is the so-called User Agent
of a device. The detection of a mobile device can be done on the client-
side (browser) and/or the server-side, and these approaches have certain
major differences.

When you want to see how a site would look on a certain mobile phone
model without using the actual device, your best bet for accurate results is
to mimic the User Agent string (UA) of the device. What happens when
you download a web page is your browser sends its UA to the server.

The UA identifies the device and the browser, and this way it’s possible
for the web server to detect and identify the browser as e.g. a Chrome
desktop browser, a Safari browser running on iPhone 6 Plus, or as the
native browser of a Samsung Galaxy 5.

Majority of the biggest websites are using server-side handset detection,
as it allows them to serve different content depending on the device
(e.g. optimize images, remove non-mobile compatible plugins, etc.). So,
if there is server-side detection of the UA in place, simply resizing your
desktop browser window will not necessarily show you the same version
and content of the website.

That’s why no matter what tool you use, it’s always good to make sure
the tool actually uses the target device’s UA string when making HTTP
requests. You will mainly need to worry about this only when you use the
built-in browser tools which we will cover later below.
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3.4. Opera Mobile Emulator for Desktop

3.3.2.2 Mobile Phone Emulator (by COWEMO)

http://www.mobilephoneemulator.com/ Mobile phone emulator is a
mobile phone emulator that enables you to test the display of any website
in many cell phones.

With this online mobile emulator (although there isn’t much information
disclosed on the accuracy of the tool), you can select lots of devices from
a dropdown list and enter your website URL to test it.

Price: Free, you can get JavaScript API access from USD $50 per month.

3.4 Opera Mobile Emulator for Desktop
Opera Mobile Emulator is software created by Opera for web developers
and designers to test websites on the Opera Mobile browser. It has the
exactly same engine and UI as Opera Mobile on mobile phones. There
are, however, some extra debugging tools available, such as keyboard
shortcuts, the profile selector, and various command-line flags. Check out
detailed description on the use of Opera Mobile Emulator.
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3.4. Opera Mobile Emulator for Desktop

Works on: Windows, Linux, Mac OS X.

Requirements: Just a download from the Opera site.

Pros:

• It’s an emulator, so you don’t need any real phones for testing.
• It comes pre-configured with a series of phone and tablet device

profiles (User Agent strings).
• There’s also an online and downloadable Opera Mini Simulator for

feature phones that run the Java-based Opera browser.
• Customizable User Agents – Users can freely change the UA string.
• Super simple to install and easy to use. No need to install any

complex SDKs or the like.
• Various input modes – There are three input modes available: touch,

keypad and tablet.
• All modes can be activated and controlled by links and controls.
• Bookmark sync – Opera Mobile Emulator can be integrated with

Opera Turbo and Opera Link to enable bookmark sync for faster
testing.

• Remote debugging with real devices – you can do remote debugging
by installing also Opera Dragonfly that contains useful features such
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3.5. Responsinator

as DOM, CSS, Network Inspectors, JavaScript Debugger, Command
Line and Error Console.

Cons:

• Media support may not be perfect.
• By default, only User Agent Strings for the platforms Opera Mobile

runs on are included. However, it’s possible to add iPhone User
Agent to Opera Mobile Emulator as a custom UA string.

• The emulator displays how pages look using the Opera Mobile
browser – as known, not all features work similarly in different
browsers. Even more so in the mobile world.

3.5 Responsinator
http://www.responsinator.com/ Responsinator – With this tool you can
quickly test mobile sites on the few top iOS and Android devices. It takes
in a URL and then outputs a sequence of device mock-ups with the web
page rendered in them, so you can get an idea of how the page layout
will be experienced by your users in various devices. It only includes a
limited set of devices, and is intended for quick visual checking rather
than seeing exact device behavior.

Price: N/A (Donation Only).
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3.6. Mobiletest.me

3.6 Mobiletest.me
http://mobiletest.me/ Very simple way of testing your mobile sites and
web applications right from your browser.

Price: $9.99/month – One price, unlimited testing. (For more information
about pricing, please see this link).
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3.7. Built-in Mobile Developer Tools of Chrome, Firefox and Safari

3.7 Built-in Mobile Developer Tools of Chrome,
Firefox and Safari
All these browsers come with built-in mobile testing tools. To access the
mobile developer tools, on all browsers you can right-click anywhere on
a website and select Inspect Element from the drop-down menu, or use
keyboard shortcuts key F12 or CTRL + SHIFT + I on Windows, or Cmd
+ Opt + I on Mac. (Further shortcut instructions for Chrome, Safari and
Firefox.)

3.7.1 Chrome’s Device Mode & Mobile Emulation

The Device Mode comes with presets of device information including
screen width, height, and device pixel ratio from popular devices, like
Nexus 5 and Samsung Galaxy series.

Changing the device also changes the User Agent string of the browser
(remember what we discussed above in the beginning?), which ensures
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3.7. Built-in Mobile Developer Tools of Chrome, Firefox and Safari

that you will also see the results of any server-side device-specific process-
ing that might be happening.

You can use these tools to:

• Test your responsive designs by emulating different screen sizes and
resolutions, including Retina displays.

• Evaluate your site’s performance using the network emulator, with-
out affecting traffic to other tabs.

• Visualize and inspect CSS media queries.
• Accurately simulate device input for touch events, geolocation, and

device orientation.
• Enhance your current debugging workflow by combining device

mode with the existing DevTools.

For more information, please visit Chrome’s official site: Device Mode &
Mobile Emulation.
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3.7. Built-in Mobile Developer Tools of Chrome, Firefox and Safari

3.7.2 Firefox’s Responsive Design View

Firefox has a mobile development view as well, allowing you to get a
preview of how a responsive design website will look on different screen
resolutions (mobile phones, tablets, PC, etc.).

However, it’s important to notice that changing the screen size this way
in Firefox does NOT change the User Agent string of the browser – it
will still show up as desktop Firefox, which means you may miss server-
side device-specific processing magic.

The UA string change is buried in Firefox’s about:config page, which is
not very handy. Luckily, there’s an extension which allows you to change
the User Agent easily: User Agent Switcher. The extension only comes
with a limited amount of devices, but you can download a lot more User
Agent strings from Techpatterns.com. You can download all UAs in the
same XML and just directly import the file to User Agent Switcher (In
Firefox, select Tools → Default User Agent → Edit User Agents → Import).

To enable the mobile development view in Firefox, select Firefox’s menu
→ Web Developer → Responsive Design View (CTRL+SHIFT+M).
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3.7. Built-in Mobile Developer Tools of Chrome, Firefox and Safari

Features:

• Size Selection
• Portrait / Landscape
• Screenshot
• Simulate touch events
• and more controls.

Now, while you change resolutions just remember to also set the UA string
accordingly with the UA Switcher extension.

Fore more information, visit Firefox Developer Tools home page.

3.7.3 Safari – Using iPhone, iPad and iPod Touch Website
Testing

Safari browser also has a built-in mobile emulator for the iOS devices, and
allows you to change the device User-Agent into also non-iOS devices.

These screenshots will guide you how to use Apple’s Safari web browser
for testing your iDevice-ready website by simulating an HTTP request
from Safari on the iPad, iPhone and iPod Touch.
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3.8. Mobile Emulators from Device Manufacturers

Check the official site of Safari Developer Tools for more details.

3.8 Mobile Emulators from Device Manufacturers
Device Manufacturers, or OEMs, typically provide desktop emulators of
their platforms. Often these are aimed more toward native application
development, but they can also be used for mobile website testing. Typi-
cally, the emulator provided by the device manufacturer or OS provider
is the closest-matching alternative to real device testing, although it’s
not always the case. In the following we will present some of these
manufacturer tools.

3.8.1 BlackBerry Simulators

BlackBerry’s simulators are provided by RIM for web developers to do
BlackBerry compatibility testing on various devices. There’s support for
keyboard, and trackpad/trackwheel/trackball input. The tools also allow
running and debugging BlackBerry applications on desktop computers.
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3.8. Mobile Emulators from Device Manufacturers

Works on: Windows, Linux and Mac OS X.

Requirements: VMware Player on Windows or VMware Fusion on Mac
needs to be installed.

Pros:

• Most of the typical device functionalities, even advanced like push
notifications, can be tested. Very close to real device.

Cons:

• Complex SDK, so there may be installation and other issues if you’re
unlucky, and if you only want to test the browser, installing whole
SDK is redundant.

3.8.2 Windows Phone Emulator

Windows Phone Emulator is a desktop tool to emulate Windows Phone
8. Installation gives you a mobile environment where you can test, view,
and debug Windows Phone apps and use the browser to check websites.
Windows Phone Emulator is designed to provide comparable performance
to an actual device.
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3.8. Mobile Emulators from Device Manufacturers

Requirements: You need to download and install Windows Phone Devel-
oper Tools.

Pros:

• Full-blown SDK with device emulator.
• Allows for in-depth developer access.
• Check on device peripherals, processor speed, RAM, display resolu-

tion and GPU.
• Lots of language versions available.

Cons:

• Only works on Windows.
• Heavy and complex SDK with lots of requirements.
• Some complaints about slow performance.

3.8.3 Android Studio

Android Studio emulator enables you to create a virtual mobile device
on which you can run Android applications and test mobile websites. It
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3.8. Mobile Emulators from Device Manufacturers

has Android system stack and includes pre-installed applications that you
can access. You can find the emulator inside Android SDK package.

Works on: Windows, Mac OS X, Linux.

Requirements: You need to download and install the Android SDK before
you can launch Android Emulator to run the browser to test your site. It
is recommended that you use Eclipse Classic version, or a Java or Eclipse
RCP version for running the Android SDK. Before doing this, make sure
that you also have Java SE Development Kit (JDK) installed on your
computer. In order to use the emulator, you must also create one or
more Android Virtual Device configurations where in each of them you
must specify which platform to run, which hardware to use and which
emulator skin is your choice. You can also run Firefox Mobile on top of
the Android SDK.

Pros:

• Full-blown SDK with device emulator.
• Allows for in-depth developer access to e.g. telephony, SMS, and SD

card emulation.
• Geo location, extensive logging capabilities.
• Very close to real device.
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Cons:

• Complex SDK with lots to install.
• Lots of unnecessary stuff if you just need the browser to test mobile

websites.

Tips: The Android SDK is quite slow – it might be better to use an
image from android-x86.org in VirtualBox.

3.9 Online Mobile Testing with Real Devices
Yes, it is also possible to test with the real mobile device online. Let’s
review some options.

3.9.1 Browshot – Testing Mobile Websites

Browshot is a service to easily create screenshots of web pages in any
screen size, as any device: iPhone, iPad, Android, Nook, PC, etc. The
service is simple to use: you get to select a mobile device, the screen
orientation, and then you can request a screenshot of any website. The
shot will be generated using the Browshot’s virtual browsers and delivered
to you almost instantly (they mention an average of 15 seconds).

There are a few limitations, however: First, there’s a quite limited set
of mobile devices; Second, apparently the screenshots are cached for 24
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hours, so same day changes with the exactly same URL won’t show up
(this could be bypassed by adding empty parameters to the URL, or using
their API). For high-volume customers the firm also offers customizable
browser setups (e.g. any screen size ratio).

Works on: Any browser.

Requirements: N/A.

Price: Browshot uses credits system for paying for the screenshots. Mobile
shots take 2 credits. You can get 20 credits for free for signing up to their
newsletter and sending a tweet. You’ll also get 100 free screenshots a
month. Credits are sold in packs starting from $1 per 10 credits and up
to $1,000 per 300,000 credits.

Pros:

• Very easy, simple, and fast to use (the average time, including page
load, to finish a screenshot is just 15s).

• Affordable pricing for small batches.
• Configurable – each feature (Flash/HTML5/CSS/JavaScript/Image

loading) can be enabled and disabled on demand. They also have
an API.

Cons:

• Limited device selection.
• Iterative development difficult with only screenshots – also, the

service caching can be a nuisance.

3.9.2 BrowserStack – Web-Based Cross Browser Testing

BrowserStack is a web service that offers a complete range of browsers
for cross browser testing. The service is available online instantly without
any downloads or installs.
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While the service started with desktop browsers, it now also includes
official mobile emulators of iOS, Android, and Opera Mobile, so you can
test how the sites work on iPhone, iPad, various Android devices, plus
some others that support Opera Mobile (see full device list). BrowserStack
also features advanced functionality like local tunnel testing of private
sites and pre-installed debugging tools.

Works on: Windows, Mac OS X (Linux coming soon).

Requirements: You don’t need to install anything, just need a browser
and Flash.

Pricing:

• Free for Open Source: We love open source projects. Choose any of
our plans. Contact us with details of your project.

• $12.50/mo for Freelancers: 100 minutes of Live. Only 1 license/ac-
count. $12.50/mo, Billed annually. $19 month-to-month.

• Live $29 license/month: For teams focused on cross-browser com-
patibility.
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• Automate $59 license/month: For teams with Selenium or
JavaScript tests.

• Automate Pro $99 license/month: For test-driven development
teams.

For more information about pricing, please see this link.

Pros:

• Instant access to iOS, Android, and Opera Mobile emulators (+ all
major desktop browsers)

• No installation required
• Advanced developer tools

Cons:

• Limited amount of different mobile devices available
• Needs a good block of available memory to run

3.9.3 Keynote Mobile Testing (DeviceAnywhere)

Keynote Mobile Testing (previously known as DeviceAnywhere) provides
testing access to a huge variety of mobile devices.
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The specialty of the service is that they actually make use of remote
connection to real devices – so it’s the real thing you are testing against,
and not just an emulator.

Keynote’s service can be used for testing of mobile websites as well as
HTML5 hybrid apps and native apps. The service is a bit skewed towards
testing apps, though.

Works on: Windows, Linux, Mac OS X.

Requirements: To test your mobile site with DeviceAnywhere, you need
to sign up for an account. After you have obtained an account, you can
download and install their software.

Pricing:

• FREE: Spot check your mobile apps and websites for a limited time
on limited number of devices.

• PRO: Manual testing of your mobile apps and websites starting at
$180 per month.

• PRO UNLIMITED: Unlimited manual testing of your mobile apps
and websites starting at $500 per month / billed annually.

• ENTERPRISE: Automated testing of your mobile apps and websites
starting at $750 per month / billed annually.
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For more information about pricing, please see this link.

Pros:

• Easy to use.
• Great device selection.
• Test using real devices.
• Lots of advanced functionality available for automating tests, etc.

Cons:

• Can get costly if you’re on limited budget.
• Clunky/slow Java UI.
• Since they use real devices, those may sometimes be broken or

unavailable.
• Limited carrier networks choice.

3.9.4 AppThwack

This website will test your website with 333 real devices (247 phones |
82 tablets | 4 PMPs).

Real, physical devices in the cloud

With AppThwack you can test your website with 300+ unique, non-
rooted phones and tablets in our state-of-the-art device lab. They have
real hardware and software, available 24/7 and 100% automated.

50

http://www.keynote.com/solutions/testing/mobile-testing#pricing


3.10. Validating

Example Test Results

Pricing:

• Free: 100 minutes of testing.
• Micro $20/mo (up to 200d).

3.10 Validating
We can validate our mobile website created with Mobile Joomla! with the
following tools:
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3.10.1 Validator.w3.org/mobile

This checker performs various tests on a Web Page to determine its level
of mobile-friendliness. The tests are defined in the mobileOK Basic Tests
1.0 specification. A Web Page is mobileOK when it passes all the tests.

If you wish to validate specific content such as markup validation, or
RSS/Atom feeds, or CSS stylesheets, or to find broken links, there are
other validators and tools available.

3.10.2 Ready.mobi

The mobiReady testing tool evaluates mobile-readiness using industry
best practices and standards. The free report provides both a score (from
1 to 5) and in-depth analysis of pages to determine how well your site
performs on a mobile device.

Provides results for a single page:

• dotMobi compliance.
• W3C mobileOK tests.
• Device emulators.
• Detailed error reports.

Provides results for markup only:

• Useful during development.
• Live site not required.
• HTTP tests ignored.
• Detailed error reports.

Provides results for a whole site:

• Site wide testing.
• Report archive.
• Enhanced emulators.
• Detailed error reports.
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Ready.mobi was developed a long time ago, and some of its suggestions
are not perfect at the present time. For example, most of the mobile
devices displays HTML markup well, but ready.mobi recommends to use
XHTML markup, etc.

3.11 Bonus: Mobile Joomla! Pro
For our Mobile Joomla! Pro users we’ve tried to make it as easy as possible
to do basic testing to see how the site looks on various devices while
tweaking settings at the same time.

Mobile Joomla! Pro preview

Mobile Joomla! Pro includes multiple back-end device simulators with
which one can easily try out how the chosen settings affect the Joomla!
site on the iPhone, Android, smartphones, and features phones.

While it may not completely remove the need to test advanced features
with a large variety of devices, our aim has been to make it fast and easy
for our professional users to make adjustments to their mobile site while
seeing the results at the same time.
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CHAPTER

4
Mobile Joomla!
Templates

IN this chapter, we will take a closer look at the structure of Mobile
Joomla!. We will discuss every section of the layout. First, we
explore the default template that comes with Mobile Joomla!. Next,

we focus on template modularization techniques. Then, we will find out
how to apply CSS on the template.

This chapter also shows how show/hide mobile and site links to our
visitors. We also learn the template positions of Mobile Joomla!. Fur-
thermore, we will explore some features of Premium Mobile Joomla!
templates.

Finally, we will cover how responsive templates can be used with Mobile
Joomla!.

4.1 Overview of Current Templates
Let’s see the current layout structure of Mobile Joomla!. All the mobile
templates have the following structure:
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4.2 Template Modularization
The last thing to do before your page is complete is to adjust the
places of your modules for the mobile page. With the installation
of Mobile Joomla!, your system got extra modules for mobile pages,
called, for example, Mobile Switcher (mod_mj_switcher) or Proxy Module
(mod_mj_proxymodule). Also, you can get extra extensions from http://
www.mobilejoomla.com/extensions.html. In your Joomla! backend go to
Extensions → Modules and you can edit their names, position in template
and other parameters.

The color schemes are easy to change with the aid of CSS. It happens by
modifying the css/custom.css file of the template. You can do it right
in the backend of your Joomla! in Extensions → Templates → Template
tab. For example, choose the “Mobile_Basic” template. In the upper-right
corner you’ll find the option to “Edit css/custom.css”. By choosing it you
can use Joomla!’s editor to change the outlook of your template by adding
your own CSS styles.

55

http://www.mobilejoomla.com/extensions.html
http://www.mobilejoomla.com/extensions.html


4.3. Styling the Mobile Site with CSS

4.3 Styling the Mobile Site with CSS
We can use CSS to style our mobile sites efficiently. Here are brief
instructions on how to style your mobile site:

• Go to Extensions → Templates → Template tab in Joomla! adminis-
tration panel.

• Pick your template: Mobile_Basic.

• Click Edit css/custom.css (or whatever CSS file you have available
there).

For example to change the header background style in Mobile_Basic
template, in css/custom.css add the part:

.ui-page␣.ui-header␣{
␣␣background:␣white;
}

Note: It is best to move your changes to css/custom.css to be sure
they won’t be overwritten after Mobile Joomla! update.

4.4 Theming and Editing Templates
In this section, we will learn ways to theme Mobile Joomla! and edit
templates. We will discuss some interesting features below.

4.4.1 The Mobile Switcher and Hiding Mobile and Web
Switching Links

The mobile switcher allows the user to choose between the web version
and the mobile version manually. Since Mobile Joomla! automatically
displays the mobile version to mobile users based on the user agent
detection, you might want to hide this for aesthetics reasons on the
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desktop website. Note that if you disable the switcher on the mobile site
also, the mobile users cannot change to the normal web version.

Follow the below steps to hide the mobile switcher setting on the desktop
website:

• Go to Extensions → Modules.

• Search for Mobile Switcher.

• Disable the one which is in the footer position (website footer).

4.4.2 Overriding Templates

Mobile Joomla! templates can be overridden the same way as
all Joomla! templates. For ways to override a template please
see the official Joomla! documentation: http://docs.joomla.org/
How_to_override_the_output_from_the_Joomla!_core.

4.5 Using Mobile Joomla! in 3rd-party Extensions
Mobile Joomla! defines a constant _MJ in “OnAfterRoute” event after
switch to mobile mode, so the simplest way to check for mobile is:

if␣(defined('_MJ'))␣{
␣␣//␣mobile␣mode
}␣else␣{
␣␣//␣desktop␣mode
}

We can retrieve the used mobile markup by the following code block:

if␣(defined('_MJ'))␣{
␣␣$mj␣=␣MobileJoomla::getInstance();
␣␣$markup␣=␣$mj->getMarkup();␣//␣'mobile'␣or␣'tablet'
}
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4.6. Template Position Settings

4.6 Template Position Settings
Joomla!’s modules can be made appear on all mobile templates, or on
only one template (e.g. if you use different templates for Mobile and
Tablet devices).

4.6.1 Front Page Settings

You can choose the home menu item, or front page item, in the Mobile
Joomla! settings.

4.7 Mobile Joomla!’s Extensions Manager
One of the reasons Joomla! is very popular is likely because of its simplicity
and versatile extensions. As of now, there are more than 7,000 extensions
in the Joomla! Extensions Directory. Some of these extensions work well
in mobile browsers, while some require minor changes in CSS to make
them look nice, but at the same time there are many extensions that work
well on desktop only. Luckily, most of such extensions are just simple
content sharing buttons, lightboxes, etc.

With Mobile Joomla!, it’s very easy to exclude some modules from the
mobile template since mobile templates have another set of module
positions.

But what to do if this extension is a plugin that is run on every page? Or
what to do if you use a responsive template, and the same modules are
displayed in both the desktop and the mobile versions? Or you would
like to display a QR code on desktop, but hide it on mobile?

They were tricky questions, but in Mobile Joomla! we implemented a
feature that allows to disable modules and/or plugins on mobile pages.

Here’s how it works:
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Image: Modules view

There is one only limitation: it’s impossible to disable plugins of the
“system” and “mobile” groups. The plugins of the first group are loaded
by Joomla! before Mobile Joomla! starts to work (and there is no way to
“unload” them), and the latter ones are used to detect mobile devices by
Mobile Joomla! itself.
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4.8 Basic_Mobile Joomla! Template

4.8.1 Highlights and Key Features:

• Compatible with Joomla! 1.5, 1.6, 1.7, 2.5 & 3.x.
• 2 color schemes (light and dark).
• Displays beautifully on iPhone, Android, Windows Phone, Black-

berry and other major devices.
• Custom logo – You can display a custom logo, title or both.
• Mobile Search Engine Optimization.
• Valid HTML5, CSS3 & JavaScript.
• Based on the rock solid jQuery Mobile framework.
• Open source, fully customizable.

4.8.2 Basic Mobile Joomla! Template Compatibility

Joomla!’s extensions are developed by 3rd parties for various purposes and
mostly for web browsers. Mobility however, requires separate thinking
and implementation, for this reason, each and every 3rd-party Joomla!
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component needs to be designed and developed separately for mobile
use.

4.8.3 Configuring Basic

You can access Basic template settings by selecting Mobile_Basic from
Extensions, Template Manager.

Basic template has various setting parameters, so that you can fine tune
your mobile site into perfection.
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4.8.3.1 Theme

Mobile_Basic template uses jQuery Mobile rich theme system, giving you
full control over page styles.

Mobile_Basic includes 2 “swatches” (color themes) that are given letters
(A and B) for quick reference.

• Grey (A): Light grey color swatch
• Black (B): Black color swatch

Page Swatch, Header Swatch, Footer Swatch. Swatches for page
content, header and footer areas correspondingly.

Module Title Swatch, Module Content Swatch. Swatches for modules
titles and content.

Pagination Swatch. Swatch used for pagination links and for Previous
and Next buttons.

Message Area Title Swatch, Message Area Text Swatch. Swatches for
title and content of Joomla! system messages.

4.8.3.2 Layout Settings

Headerbar and Footer toolbars support following options:

• Hide. Don’t display toolbar on webpages.
• Standard. Standard toolbar at the top (header bar) or bottom

(footer) of the window.
• Fixed. This will make toolbar remains at the top (header bar) or

bottom (footer) of the window at all time instead of scrolling with
the page.

• Fullscreen. Overlays the toolbar over the content.
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4.8.3.3 Homepage Layout Settings

Show in Header. You can define what will be displayed in your mobile
web header.

• Logo: Displays a logo, replacing the header title for the main page
only. A logo image patch should be defined below.

• Title (default): Displays only title text on all mobile pages.
• Logo and title: Displays both logo and title on mobile pages.

Header Logo Image. If you select logo or logo & title options above,
you can give logo image path here (/templates/mobile_basic/logo.png
by default). Please make sure that logos are 42px high (recommended
values are w:150px, h:42px, transparent PNG).

4.8.3.4 Advanced

Enable Zooming. Enables/disables page zooming using pinch gesture (if
supported by browser).

Autodetect Phone Numbers. Enable/disable phone numbers detecting
by browser (if supported).

Autodetect Addresses. Enable/disable addresses detecting by browser
(if supported).

Enable Enhance Management. Enhance Management is a jQuery Mobile
feature that allows to don’t change style of specified page content.

Disable Enhancing for Components. Select components that should be
displayed in its original form (i.e. without applying additional theming).

Load jQuery from CDN. You can load jQuery Mobile framework from
jQuery’s CDN servers remotely. Loading the framework remotely may be
faster than compared to local option.

jQuery Version. Which jQuery version to load (1.9.1 by default).
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Load jQuery Migrate. Load jQuery Migrate script to fix legacy jQuery
plugins.

Load MooTools. Force loading of MooTools library (may be necessary to
fix issues with 3rd-party extensions).

Autofix Bootstrap Loading. Fix conflict of Bootstrap and jQuery Mobile
frameworks.

Autofix jQuery UI Loading. Fix loading of jQuery UI framework by
3rd-party extensions.

Remove Other jQuery Libraries. Remove all jQuery files from 3rd-party
extensions.

4.8.3.5 Icons

When users add your mobile site into their iPhone Home Screen, an app
icon is displayed for easy and full screen access. By default, a placeholder
icon is placed under /templates/mobile_basic/ directory for:

• touch-icon-57x57.png Default icon used by most of the modern
mobile devices, an image of size 57x57px.

• touch-icon-114x114.png Icon for iPhone4 with Retina display.

Note that iPhones and iPads process this images by adding round corners,
highlights, etc. But there is a way to use “precomposed” images that will
be displayed as is:

• touch-icon-precomposed-57x57.png Precomposed image for
iPhone3/iPod.

• touch-icon-precomposed-114x114.png Precomposed image for
iPhone4 & the new iPad.

To upload new image file, just click on corresponding image. To remove
the file, click on red cross in the top-right corner of the image.
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4.8.4 Module Styles

A module with hidden title (you can show or hide a module title in a
module’s settings page) is displayed as is, without expand/collapse. A
module with a title is displayed as a collapsed block with title where full
module content is displayed when tapped. Behavior of this feature may
be changed by setting “Module Class Suffix” module’s parameter to the
following values:

• open – Display module expanded initially;
• popup – Display module as a button and display content in popup

after tapping;
• nostyle – Don’t apply jQuery Mobile styling at all;
• inset – Apply inset style to listviews. It is applicable to modules

with listviews (Menus, Latest Articles, etc.) and make it to be inset
instead of full width.

Below are some examples of listed styles:

Hidden title:
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Hidden title with inset style:

Title on:

Title on with “open” style:
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Title on with “nostyle”:

Title on with “popup”:

4.8.5 Advanced Customization of the Basic Template

4.8.5.1 Custom CSS

Basic template can be customized further, using css/custom.css file. You
can define CSS rules in such file and customize Basic template for your
needs or site compatibility. Such file doesn’t exist by default (you should
create one) and will not be overwritten if you update your template. But
we recommend you to back it up regularly.

4.8.5.2 Custom JavaScript

Similar to css/custom.css, the js/custom.js file has the same purpose
but for JavaScript. To access jQuery object use global jqm variable.
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4.8.5.3 JavaScript and CSS Loading Manipulation

Some 3rd-party extensions may conflict with jQuery Mobile library or AJAX
navigation. In this case it’s reasonable to exclude some JS/CSS files from
loading, or reorder them. Basic template provides such a functionality via
js/custom_preload.txt and css/custom_preload.txt files. Each line
of these files describe certain action depending on its first character:

#␣:␣comment
-␣:␣this␣URL␣shouldn't␣be␣loaded
*␣:␣this␣URL␣should␣be␣included␣before␣jQuery␣Mobile
otherwise:␣this␣URL␣should␣be␣included␣after␣jQuery␣Mobile

␣(in␣standard␣way)

4.9 Elegance Mobile Joomla! Template

Elegance is our first premium Mobile Joomla! template based on jQuery
Mobile framework. We really wanted to design something special, so we
went through a long process carefully crafting all small details to bring
you a solid mobile template of the finest quality, a true mark of mobile
design craftsmanship and elegance.

Elegance may be considered as an extended version of Basic template, so
all documentation in previous section is actual for Elegance as well.
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4.9.1 Elegance Highlights and Key Features:

• Compatible with Joomla! 1.5, 1.6, 1.7, 2.5 & 3.x.
• 2 different default color schemes. More can be easily gener-

ated with jQuery Mobile ThemeRoller: http://jquerymobile.com/
themeroller/.

• AJAX navigation.
• 9 different AJAX animations for page transitions.
• optional login and search modules in header bar.
• Displays beautifully on iPhone, Android, Windows Phone, Black-

berry and other major devices.
• App mode – Let anyone add your site on iPhone home menu &

browse full screen.
• Mobile Search Engine Optimization.
• Valid HTML5, CSS3 & JavaScript.
• Open source, fully customizable.
• Full compatibility with all Mobile Joomla! Extensions.
• Full documentation, premium forums, continuous improvements &

updates.

4.9.2 Elegance Mobile Joomla! Template Compatibility

Joomla!’s extensions are developed by 3rd parties for various purposes and
mostly for web browsers. Mobility however, requires separate thinking
and implementation, for this reason, each and every 3rd-party Joomla!
component needs to be designed and developed separately for mobile
use.

Elegance Mobile Joomla! template supports all native Joomla! fea-
tures, (almost) all existing Mobile Joomla! extensions and all upcom-
ing ones. However, it does not officially support 3rd-party Joomla! ex-
tensions, unless they are listed among compatible extensions list. If
an extension (component or module) is listed, it means, it’s officially
tested and compatible with Elegance template. Please see the latest list
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of compatible extensions at: http://www.mobilejoomla.com/templates/
86-elegance-mobile-joomla-template.html.

There may be incompatibilities with 3rd-party extensions in the following
cases:

• AJAX navigation may work incorrectly or don’t work at all when the
extension uses AJAX-incompatible JavaScript or there is a conflict
of CSS of different pages.

• The extension loads another jQuery instances that interferes with
jQuery Mobile object (the template switches to jQuery’s noconflict
mode to minimize such a conflict, but there is no 100% guarantee).

4.9.3 Installing Elegance Template

Installing a Mobile Joomla! template is not much different from installing
a desktop Joomla! template.

1. Login to your site backend from the Administration panel.

2. Go to Extension Manager.
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3. Browse the correct template file (1.).

4. Click Upload & Install (2.).

5. If you see success message, continue. Otherwise, please fix the error
or ask for help at Mobile Joomla! forum.

6. Go to Mobile Joomla! component.

7. Select the new template for each device (usually under Smartphone
and iPhone tabs), at the Settings sections from the Template dropdown
menu.
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8. Save settings.

4.9.4 Configuring Elegance

You can access Elegance template settings by selecting mobile_elegance
from Extensions, Template Manager.

Elegance template has various setting parameters, so that you can fine
tune your mobile site into perfection.
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4.9.4.1 AJAX

Use AJAX Navigation

If you decide to use this option, jQuery Mobile will automatically han-
dle links and form submissions through AJAX, where possible. This is
required for below “AJAX page transition” to work. Please note that AJAX
navigation may be incompatible with some 3rd-party extensions, such as
Google AdSense (read more at Compatibility section).

AJAX Page Transition

Sets the transition effect for pages (“Use AJAX Navigation” option is
required):

• None: No animation is used for page transitions.
• Fade (default): Pages fade in.
• Slide: Slide animation (left to right, or vice-versa).
• Slide up: Slide up animation (bottom to top).
• Slide down: Slide down animation (top to bottom).
• Pop: New pages pops up as in popup alerts.
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• Flip: Flip animation.
• Turn: Turn animation.
• Flow: Flow animation.
• Slide Fade: Slide old page and fade new one.

4.9.4.2 WebApp

Fullscreen WebApp

If you turn this on, when users add your webpage on their Home Screen
on iPhone, it sets the application window to fullscreen as a WebApp.

Status Bar for WebApp

Sets the style of the status bar of the web app mode:

• Default: Uses system default.
• Black: Uses black status bar.
• Black Translucent: Uses black translucent status bar.

4.9.4.3 Theme

In addition to default jQuery Mobile theme you can create your own
themes at jQuery Mobile ThemeRoller. To start, click “Generate” link.
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After you create and download theme (“Download theme zip file” at
the header bar), upload it to your site using corresponding field near
“Generate” link. Then you can choose new theme in “Theme” dropdown
list.

4.9.5 Advanced Customization

All customizations described previously for Mobile_Basic template may
be used for Elegance as well. For example, this js/custom.js file could
be used to disable AJAX for certain links:

jqm(":jqmData(role='page')").live('pagebeforecreate',␣

function(){

␣␣jqm(this).find("a[href$='.mp3']").attr('data-ajax',␣

'false');␣//␣mp3␣files

␣␣jqm(this).find("a.modal").attr('data-ajax',␣'false');␣

//␣default␣MooTools␣popups

␣␣jqm(this).find("a.highslide").attr('data-ajax',␣'false')

;␣//␣Highslide␣plugin

␣␣jqm(this).find("a.modal-button").attr('data-ajax',␣

'false');␣//␣PhocaGallery
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␣␣jqm(this).find("a[relˆ='rokbox']").attr('data-ajax',␣

'false');␣//␣Rokbox␣plugin

});

4.10 Flat Mobile Joomla! Template
Flat Mobile template is based on Flat UI Kit and includes 7 “swatches”
(color themes) that are given letters (A, B, C, D, E, F, G) for quick refer-
ence.

Default swatches for modules, pagination and message area inherit
swatch of corresponding container (page or footer).

4.10.1 Flat Highlights and Key Features:

• Compatible with Joomla! 1.5, 1.6, 1.7, 2.5 & 3.x.
• 7 different default color schemes.
• AJAX navigation
• 9 different AJAX animations for page transitions.
• optional login and search modules in header bar
• Displays beautifully on iPhone, Android, Windows Phone, Black-

berry and other major devices.
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• App mode – Let anyone add your site on iPhone home menu &
browse full screen.

• Mobile Search Engine Optimization.
• Valid HTML5, CSS3 & JavaScript.
• Open source, fully customizable.
• Full compatibility with all Mobile Joomla! Extensions.
• Full documentation, premium forums, continuous improvements &

updates.

4.10.2 Flat Mobile Joomla! Template Compatibility

Joomla!’s extensions are developed by 3rd parties for various purposes and
mostly for web browsers. Mobility however, requires separate thinking
and implementation, for this reason, each and every 3rd-party Joomla!
component needs to be designed and developed separately for mobile
use.

Flat Mobile Joomla! template supports all native Joomla! features, (al-
most) all existing Mobile Joomla! extensions and all upcoming ones.
However, it does not officially support 3rd-party Joomla! extensions, un-
less they are listed among compatible extensions list. If an extension
(component or module) is listed, it means, it’s officially tested and com-
patible with Flat template. Please see the latest list of compatible ex-
tensions at: http://www.mobilejoomla.com/templates/184-flat-mobile-
joomla-template.html.

There may be incompatibilities with 3rd-party extensions in the following
cases:

• AJAX navigation may work incorrectly or don’t work at all when the
extension uses AJAX-incompatible JavaScript or there is a conflict
of CSS of different pages.

• The extension loads another jQuery instances that interferes with
jQuery Mobile object (the template switches to jQuery’s noconflict
mode to minimize such a conflict, but there is no 100% guarantee).
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4.10.3 Installing Flat Template

Installing a Mobile Joomla! template is not much different from installing
a desktop Joomla! template.

1. Login to your site backend from the Administration panel.

2. Go to Extension Manager.

3. Browse the correct template file (1.).

78



4.10. Flat Mobile Joomla! Template

4. Click Upload & Install (2.).

5. If you see success message, continue. Otherwise, please fix the error
or ask for help at Mobile Joomla! forum.

6. Go to Mobile Joomla! component.

7. Select the new template for each device (usually under Smartphone
and iPhone tabs), at the Settings sections from the Template dropdown
menu.

8. Save settings.
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4.10.4 Configuring Flat

You can access Flat template settings by selecting mobile_flat from Exten-
sions, Template Manager.

Flat template has various setting parameters, so that you can fine tune
your mobile site into perfection.

4.10.4.1 AJAX

Use AJAX Navigation

If you decide to use this option, jQuery Mobile will automatically han-
dle links and form submissions through AJAX, where possible. This is
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required for below “AJAX page transition” to work. Please note that AJAX
navigation may be incompatible with some 3rd-party extensions, such as
Google AdSense (read more at Compatibility section).

AJAX Page Transition

Sets the transition effect for pages (“Use AJAX Navigation” option is
required):

• None: No animation is used for page transitions.
• Fade (default): Pages fade in.
• Slide: Slide animation (left to right, or vice-versa).
• Slide up: Slide up animation (bottom to top).
• Slide down: Slide down animation (top to bottom).
• Pop: New pages pops up as in popup alerts.
• Flip: Flip animation.
• Turn: Turn animation.
• Flow: Flow animation.
• Slide Fade: Slide old page and fade new one.

4.10.4.2 WebApp

Fullscreen WebApp

If you turn this on, when users add your webpage on their Home Screen
on iPhone, it sets the application window to fullscreen as a WebApp.

Status Bar for WebApp

Sets the style of the status bar of the web app mode:

• Default: Uses system default.
• Black: Uses black status bar.
• Black Translucent: Uses black translucent status bar.
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4.10.5 Advanced Customization

All customizations described previously for Mobile_Basic template may
be used for Flat as well. For example, this js/custom.js file could be
used to disable AJAX for certain links:

jqm(":jqmData(role='page')").live('pagebeforecreate',␣

function(){

␣␣jqm(this).find("a[href$='.mp3']").attr('data-ajax',␣

'false');␣//␣mp3␣files

␣␣jqm(this).find("a.modal").attr('data-ajax',␣'false');␣

//␣default␣MooTools␣popups

␣␣jqm(this).find("a.highslide").attr('data-ajax',␣'false')

;␣//␣Highslide␣plugin

␣␣jqm(this).find("a.modal-button").attr('data-ajax',␣

'false');␣//␣PhocaGallery

␣␣jqm(this).find("a[relˆ='rokbox']").attr('data-ajax',␣

'false');␣//␣Rokbox␣plugin

});

4.11 Square Mobile Joomla! Template
Square Mobile is another flat-like template and includes 8 “swatches”
(color themes) that are given letters (A, B, C, D, E, F, G, H) for quick
reference.
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Default swatches for modules, pagination and message area inherit
swatch of corresponding container (page or footer).

4.11.1 Square Highlights and Key Features:

• Compatible with Joomla! 1.5, 1.6, 1.7, 2.5 & 3.x.
• 8 different default color schemes.
• AJAX navigation
• 9 different AJAX animations for page transitions.
• optional login and search modules in header bar
• Displays beautifully on iPhone, Android, Windows Phone, Black-

berry and other major devices.
• App mode – Let anyone add your site on iPhone home menu &

browse full screen.
• Mobile Search Engine Optimization.
• Valid HTML5, CSS3 & JavaScript.
• Open source, fully customizable.
• Full compatibility with all Mobile Joomla! Extensions.
• Full documentation, premium forums, continuous improvements &

updates.
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4.11.2 Square Mobile Joomla! Template Compatibility

Joomla!’s extensions are developed by 3rd parties for various purposes and
mostly for web browsers. Mobility however, requires separate thinking
and implementation, for this reason, each and every 3rd-party Joomla!
component needs to be designed and developed separately for mobile
use.

Square Mobile Joomla! template supports all native Joomla! features, (al-
most) all existing Mobile Joomla! extensions and all upcoming ones.
However, it does not officially support 3rd-party Joomla! extensions,
unless they are listed among compatible extensions list. If an exten-
sion (component or module) is listed, it means, it’s officially tested
and compatible with Square template. Please see the latest list of
compatible extensions at: http://www.mobilejoomla.com/templates/
86-elegance-mobile-joomla-template.html.

There may be incompatibilities with 3rd-party extensions in the following
cases:

• AJAX navigation may work incorrectly or don’t work at all when the
extension uses AJAX-incompatible JavaScript or there is a conflict
of CSS of different pages.

• The extension loads another jQuery instances that interferes with
jQuery Mobile object (the template switches to jQuery’s noconflict
mode to minimize such a conflict, but there is no 100% guarantee).

4.11.3 Installing Square Template

Installing a Mobile Joomla! template is not much different from installing
a desktop Joomla! template.

1. Login to your site backend from the Administration panel.
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2. Go to Extension Manager.

3. Browse the correct template file (1.).

4. Click Upload & Install (2.).
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5. If you see success message, continue. Otherwise, please fix the error
or ask for help at Mobile Joomla! forum.

6. Go to Mobile Joomla! component.

7. Select the new template for each device (usually under Smartphone
and iPhone tabs), at the Settings sections from the Template dropdown
menu.

8. Save settings.

86



4.11. Square Mobile Joomla! Template

4.11.4 Configuring Square

You can access Square template settings by selecting mobile_square from
Extensions, Template Manager.

Square template has various setting parameters, so that you can fine tune
your mobile site into perfection.

4.11.4.1 AJAX

Use AJAX Navigation

If you decide to use this option, jQuery Mobile will automatically han-
dle links and form submissions through AJAX, where possible. This is
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required for below “AJAX page transition” to work. Please note that AJAX
navigation may be incompatible with some 3rd-party extensions, such as
Google AdSense (read more at Compatibility section).

AJAX Page Transition

Sets the transition effect for pages (“Use AJAX Navigation” option is
required):

• None: No animation is used for page transitions.
• Fade (default): Pages fade in.
• Slide: Slide animation (left to right, or vice-versa).
• Slide up: Slide up animation (bottom to top).
• Slide down: Slide down animation (top to bottom).
• Pop: New pages pops up as in popup alerts.
• Flip: Flip animation.
• Turn: Turn animation.
• Flow: Flow animation.
• Slide Fade: Slide old page and fade new one.

4.11.4.2 WebApp

Fullscreen WebApp

If you turn this on, when users add your webpage on their Home Screen
on iPhone, it sets the application window to fullscreen as a WebApp.

Status Bar for WebApp

Sets the style of the status bar of the web app mode:

• Default: Uses system default.
• Black: Uses black status bar.
• Black Translucent: Uses black translucent status bar.
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4.11.5 Advanced Customization

All customizations described previously for Mobile_Basic template may
be used for Square as well. For example, this js/custom.js file could be
used to disable AJAX for certain links:

jqm(":jqmData(role='page')").live('pagebeforecreate',␣

function(){

␣␣jqm(this).find("a[href$='.mp3']").attr('data-ajax',␣

'false');␣//␣mp3␣files

␣␣jqm(this).find("a.modal").attr('data-ajax',␣'false');␣

//␣default␣MooTools␣popups

␣␣jqm(this).find("a.highslide").attr('data-ajax',␣'false')

;␣//␣Highslide␣plugin

␣␣jqm(this).find("a.modal-button").attr('data-ajax',␣

'false');␣//␣PhocaGallery

␣␣jqm(this).find("a[relˆ='rokbox']").attr('data-ajax',␣

'false');␣//␣Rokbox␣plugin

});

4.12 iOS9 Mobile Joomla! Template
iOS9 is a premium Mobile Joomla! template based on the rock-solid
jQuery Mobile framework & Mobile Joomla!’s powerful server-side op-
timization engine. It has similar functionality as the Elegance Mobile
Joomla! template.
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Default swatches for modules, pagination and message area inherit
swatch of corresponding container (page or footer).

4.12.1 iOS9 Highlights and Key Features:

• Compatible with Joomla! 1.5, 1.6, 1.7, 2.5 & 3.x.
• 7 different default color schemes.
• AJAX navigation
• 9 different AJAX animations for page transitions.
• optional login and search modules in header bar
• Displays beautifully on iPhone, Android, Windows Phone, Black-

berry and other major devices.
• App mode – Let anyone add your site on iPhone home menu &

browse full screen.
• Mobile Search Engine Optimization.
• Valid HTML5, CSS3 & JavaScript.
• Open source, fully customizable.
• Full compatibility with all Mobile Joomla! Extensions.
• Full documentation, premium forums, continuous improvements &

updates.

4.12.2 iOS9 Mobile Joomla! Template Compatibility

Joomla!’s extensions are developed by 3rd parties for various purposes and
mostly for web browsers. Mobility however, requires separate thinking
and implementation, for this reason, each and every 3rd-party Joomla!
component needs to be designed and developed separately for mobile
use.

iOS9 Mobile Joomla! template supports all native Joomla! features, (al-
most) all existing Mobile Joomla! extensions and all upcoming ones.
However, it does not officially support 3rd-party Joomla! extensions, un-
less they are listed among compatible extensions list. If an extension
(component or module) is listed, it means, it’s officially tested and compat-
ible with iOS9 template. Please see the latest list of compatible extensions
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at: http://www.mobilejoomla.com/templates/223-ios-9-mobile-joomla-
template.html.

There may be incompatibilities with 3rd-party extensions in the following
cases:

• AJAX navigation may work incorrectly or don’t work at all when the
extension uses AJAX-incompatible JavaScript or there is a conflict
of CSS of different pages.

• The extension loads another jQuery instances that interferes with
jQuery Mobile object (the template switches to jQuery’s noconflict
mode to minimize such a conflict, but there is no 100% guarantee).

4.12.3 Installing iOS9 Template

Installing a Mobile Joomla! template is not much different from installing
a desktop Joomla! template.

1. Login to your site backend from the Administration panel.

2. Go to Extension Manager.
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3. Browse the correct template file (1.).

4. Click Upload & Install (2.).

5. If you see success message, continue. Otherwise, please fix the error
or ask for help at Mobile Joomla! forum.

6. Go to Mobile Joomla! component.

7. Select the new template for each device (usually under Smartphone
and iPhone tabs), at the Settings sections from the Template dropdown
menu.
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8. Save settings.

4.12.4 Configuring iOS9

You can access Square template settings by selecting mobile_square from
Extensions, Template Manager.

iOS9 template has various setting parameters, so that you can fine tune
your mobile site into perfection.
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4.12.4.1 AJAX

Use AJAX Navigation

If you decide to use this option, jQuery Mobile will automatically han-
dle links and form submissions through AJAX, where possible. This is
required for below “AJAX page transition” to work. Please note that AJAX
navigation may be incompatible with some 3rd-party extensions, such as
Google AdSense (read more at Compatibility section).

AJAX Page Transition

Sets the transition effect for pages (“Use AJAX Navigation” option is
required):

• None: No animation is used for page transitions.
• Fade (default): Pages fade in.
• Slide: Slide animation (left to right, or vice-versa).
• Slide up: Slide up animation (bottom to top).
• Slide down: Slide down animation (top to bottom).
• Pop: New pages pops up as in popup alerts.
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• Flip: Flip animation.
• Turn: Turn animation.
• Flow: Flow animation.
• Slide Fade: Slide old page and fade new one.

4.12.4.2 WebApp

Fullscreen WebApp

If you turn this on, when users add your webpage on their Home Screen
on iPhone, it sets the application window to fullscreen as a WebApp.

Status Bar for WebApp

Sets the style of the status bar of the web app mode:

• Default: Uses system default.
• Black: Uses black status bar.
• Black Translucent: Uses black translucent status bar.

4.12.5 Advanced Customization

All customizations described previously for Mobile_Basic template may
be used for Square as well. For example, this js/custom.js file could be
used to disable AJAX for certain links:

jqm(":jqmData(role='page')").live('pagebeforecreate',␣

function(){

␣␣jqm(this).find("a[href$='.mp3']").attr('data-ajax',␣

'false');␣//␣mp3␣files

␣␣jqm(this).find("a.modal").attr('data-ajax',␣'false');␣

//␣default␣MooTools␣popups

␣␣jqm(this).find("a.highslide").attr('data-ajax',␣'false')

;␣//␣Highslide␣plugin

␣␣jqm(this).find("a.modal-button").attr('data-ajax',␣

'false');␣//␣PhocaGallery
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␣␣jqm(this).find("a[relˆ='rokbox']").attr('data-ajax',␣

'false');␣//␣Rokbox␣plugin

});

4.13 Faster Responsive Templates With Mobile
Joomla!
In this section, we will take a closer look at how Mobile Joomla! can be
used with responsive templates.

Many people use the so-called responsive templates for fast and easy
“mobile-ready” display for Joomla! sites. However, have you also heard
of the shortcomings of responsive templates? Bad news – there are some.
Good news – there is an easy solution for the Joomla! community.

First, let’s take a look at the two major approaches to display websites on
mobile devices: Client-side and server-side solutions.

4.13.1 Client-side Solutions

Responsive templates are client side solutions, which are designed to
adapt their look and content across devices, and based on the browser
capabilities they are viewed. This means a single source template can
deliver a consistent and good-looking experience on a wide range of
devices, such as smartphones & tablets. However, as described, responsive
templates “adapt”, they are “single source” and “client-side”.

In practice this means that when your visitors view your website on
an iPhone, they download assets of all other devices (i.e. desktops and
tablets) as well and images are downloaded in original (desktop) size
and just adjusted. This usually results in several megabytes of data and
hundreds of HTTP requests, and means a lot of unnecessary data usage,
time and battery loss for your visitors. This may not seem a lot for a
desktop visitor on a broadband, however it does matter for a mobile
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visitor on 3G who needs to wait 20 or more seconds for a single megabyte
to download.

4.13.2 Server-side Solutions

Server side solutions, on the other hand, can detect your visitors’ device
and send only the required and suitable assets. This means, everything
can be known and optimized, before they are delivered to a visitor’s
browser. Surely, this approach needs much detailed thinking, design
and implementation, and is usually more costly than other alternatives.
However, if you are serious about your business and want to minimize
visitor bounces and maximize their time on site, it is definitely worth the
investment.

4.13.3 RESS

Towards late 2011, a hybrid solution was suggested to bring advantages
of two worlds together and eliminate disadvantages, called RESS (Re-
sponsive Web Design + Server Side Components). RESS is neither a pure
client, nor a pure server-side solution. In a nutshell, RESS optimizes
certain assets of responsive templates on the server-side, so that they
work and perform better on mobile devices. So, if you could somehow
turn your responsive template into RESS, you could help your mobile
visitors save loads of data, time, and battery life. Well, luckily, you are
using Joomla!
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4.13.4 Mobile Joomla! Turns Responsive Joomla! Templates into
RESS

Mobile Joomla! is a server-side solution, with which you can finely op-
timize your Joomla! website’s look, modules, plugins, URL, media, and
other assets on various mobile devices (i.e. iPhone, Android, iPad, etc.)
with ease. As a not very widely known fact, any responsive Joomla!
template could be turned into RESS when used with Mobile Joomla!.
That’s as simple as installing Mobile Joomla! and selecting your respon-
sive template for each device category, and voilà! In a couple of minutes,
and without any cost, you have a RESS mobilization solution for your
Joomla! site!

4.13.5 Mobile Joomla! Responsive Template Analyzer

We built Mobile Joomla! Responsive Template Analyzer to test responsive
template performances with Mobile Joomla!. The tool turned out really
great, and we decided to release it for everyone to benefit! Now you
can test your Joomla! website and see the performance boost you could
get by turning your template into RESS using Mobile Joomla!. The tool
simply analyzes your website assets and tries to estimate what kind of
performance increase you would achieve. We say “tries to estimate,” since
there are many variables, and it’s not possible to know exact figures until
you install and use Mobile Joomla! on your site.
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We tested some of the most popular responsive Joomla! templates out
there, and saw that some Joomla! websites would perform 400% faster
on mobile devices, if they were using Mobile Joomla!
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If you use responsive templates, you can go ahead and test your web-
site with Mobile Joomla! Responsive Template Analyzer and check the
Analyzer report to see the potential performance boost you could get.
Then download Mobile Joomla!, and install to improve your responsive
Joomla! template performance on mobile devices for real.
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CHAPTER

5
Customizing
Mobile Joomla!

IN this chapter we will investigate the current architecture of Mobile
Joomla!. Then we will show how we can download the source from
GitHub. Note that all contributors will need to fill in the contribution

agreement that we will cover below. We’ll also go through the localization
mechanism of Mobile Joomla!.

5.1 Introduction to Mobile Joomla! Architecture
Mobile Joomla! is a set of extensions to optimize your Joomla! site for
mobile easily:

1) Mobile Joomla! component – responsible for MJ backend settings
page and installation/uninstallation of MJ extensions.

2) “Mobile Joomla!” plugin – core of Mobile Joomla!, it sets the cor-
rect template depending on the device class, changes to mobile
homepage, etc.

3) “Mobile – Simple”, “Mobile – AMDD” plugins are used to detect
device capabilities. It’s sufficient to have one of them to be enabled
(published) only.
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4) “Mobile – Always” plugin allows using specified mobile mode for
any device (including desktop browsers). It can be used for test
purposes, or to develop a mobile-only website.

5) “Mobile – Domain” plugin processes multi-domain configurations
and sets mobile mode depending on the (sub)domain.

6) “Quickicon – Mobile Joomla! CPanel Icon” plugin and “Mobile
Joomla! CPanel Icon” module (in Joomla! prior to 2.5) are used
to display MJ icon (and check for updates) in Joomla! dashboard
page.

7) “Mobile Switcher” module displays links to switch between different
view modes (Desktop, Mobile, Tablet). By default, Mobile Joomla!
installs two instances of this module: in “mj_footer” position for
mobile templates and in “footer” position for desktop template.

8) Mobile_Basic is preinstalled mobile template.

5.2 Working with Mobile Joomla! Source Code
You can contribute to Mobile Joomla! code base. Mobile Joomla! is
available on GitHub. One can get the code, make changes, and make
a pull request on GitHub. If the Mobile Joomla! team finds your work
helpful, it will accept your pull request and your work will be submitted
to main stream of the code base.

5.2.1 How to Set up Mobile Joomla! Development (trunk)
Version

We will follow the below steps to get a working copy into our local
machine:

• First, you need to have a git clone into your machine with the below
command:

git␣clone␣http://github.com/mobilejoomla/mobilejoomla.git
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• After having the code base on your machine, we can use the normal
git commands to contribute on the Mobile Joomla! code base.

• To make installation package, copy repository to new directory, run
build.sh script, and zip content of the directory.

• Install your copy of Mobile Joomla! using Joomla! extension install
mechanism.

Tips: You need to install git on your computer. Follow your OS
instructions or download git for Windows to install the application.

5.3 Mobile Joomla! Contributor Agreement
Mobile Joomla! contribution agreements guarantees that all code entering
into Mobile Joomla! development tree is safe to put under GNU General
Public License. All contributors must agree this condition before Mobile
Joomla! team accepts the contributions.

We know this is a small inconvenience, but we hope to make it as simple
as possible for you. Please fill in your personal details in the agreement
below and email it to hello@mobilejoomla.com.

5.3.1 Mobile Joomla! Contributor Agreement Template

These terms apply to your contribution of materials to the Kuneri Ltd.
(“us”/“our”), and set out the intellectual property rights you grant to us in
the contributed materials. If this contribution is on behalf of a company,
the term “you” will also mean the company you identify below. If you
agree to be bound by these terms, fill in the information requested below
and provide your signature.

Read this agreement carefully before signing.
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The term “contribution” means any source code, object code, patch, tool,
sample, graphic, specification, manual, documentation, or any other
material posted or submitted by you to the project.

With respect to any worldwide copyrights, or copyright applications and
registrations, in your contribution:

you assign to us joint ownership through this document, and to the extent
that such assignment is or becomes invalid, ineffective or unenforceable,
through this document you grant to us a perpetual, irrevocable, non-
exclusive, worldwide, no-charge, royalty-free, unrestricted license to
exercise all rights under those copyrights. This includes, at our option,
the right to sublicense these same rights to third parties through multiple
levels of sublicensees or other licensing arrangements;

you agree that each of us can do all things in relation to your contribution
as if each of us were the sole owners, and if one of us makes a derivative
work of your contribution, the one who makes the derivative work (or
has it made) will be the sole owner of that derivative work;

you agree that you will not assert any moral rights in your contribution
against us, our licensees or transferees;

you agree that we may register a copyright in your contribution and
exercise all ownership rights associated with it; and

you agree that neither of us has any duty to consult with, obtain the con-
sent of, pay, or give an accounting to the other for any use or distribution
of your contribution.

With respect to any patents you own, or that you can license without
payment to any third party, through this document you grant to us a
perpetual, irrevocable, non-exclusive, worldwide, no-charge, royalty-free
license to:

make, have made, use, sell, offer to sell, import, and otherwise transfer
your contribution in whole or in part, alone or in combination with or
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included in any product, work or materials arising out of the project to
which your contribution was submitted, and

at our option, to sublicense these same rights to third parties through
multiple levels of sublicensees or other licensing arrangements.

Except as set out above, you keep all right, title, and interest in your
contribution. The rights that you grant to us under these terms are
effective on the date you first submitted a contribution to us, even if
your submission took place before the date you sign these terms. Any
contribution we make available under any license will also be made
available under a Free Culture (as defined by http://freedomdefined.org)
or Free Software/Open Source license (as defined and approved by the
Free Software Foundation or the Open Source Initiative).

We may time to time update this agreement and announce it on the
respective developer forums. You are responsible to come back on this
page and notify us if you wish to opt out from the changed agreement
terms within 30 days of the announcement.

With respect to your contribution, you represent that it is an original work
and that you can legally grant the rights set out in these terms;

it does not to the best of your knowledge violate any third party’s copy-
rights, trademarks, patents, or other intellectual property rights; and

you are authorized to sign this contract on behalf of your company (if
identified below).

The place of performance is the registered seat of Kuneri Ltd. P.O 209,
90101 Oulu, Finland Business id: 2073578-4.

Any disputes concerning this agreement including the issue of its valid
conclusion and its pre and past contractual effects are exclusively decided
by the competent court in OULU, FINLAND or, at our discretion, also by
the competent court is whose district you may have your residence, your
registered seat, an establishment or assets. If available, please list your
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Mobile Joomla! Development username(s) for the MOBILEJOOMLA.COM
site and GitHub systems.

I hereby confirm that I read and agree Mobile Joomla! Contributor Agree-
ment.

GitHub username:

Mobilejoomla.com username:

Your name:

Your company’s name (if applicable):

Mailing address:

Telephone:

Email:

Date:

To complete this agreement email a copy of the agreement text with your
personal information filled in to �hello@mobilejoomla.com.

This agreement is based on version 1.5 of the Sun Contributor Agreement,
which can be found at: http://www.sun.com/software/opensource/
contributor_agreement.jsp. This document is licensed under a Cre-
ative Commons Attribution-Share Alike 3.0 Unported License http://
creativecommons.org/licenses/by-sa/3.0.

5.4 Localizing Mobile Joomla!
As Mobile Joomla! consists of several subextensions (plugins, modules,
templates), its language strings are contained in several files:

• en-GB.com_mobilejoomla.ini – backend strings

• en-GB.com_mobilejoomla.menu.ini – system backend strings for
Joomla! 1.5
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• en-GB.com_mobilejoomla.sys.ini – system backend strings for
Joomla! 1.6+

• en-GB.plg_mobile_always.ini – strings for Mobile – Forever plu-
gin

• en-GB.plg_mobile_amdd.ini – strings for Mobile – AMDD plugin

• en-GB.plg_mobile_mjpro.ini – strings for Mobile Joomla! Pro

• en-GB.tpl_mobile_basic.ini – strings for Mobile_Basic template

• en-GB.tpl_mobile_elegance.ini – strings for Elegance template

You can translate these files into any language in standard way by re-
naming en-GB prefix and putting them into corresponding language
directory (language/lang-prefix or administrator/language/lang-prefix).
Some translations are shared on Mobile Joomla!’s forum in Language
category.

5.5 Solving Conflicts with Other Extensions
Some 3rd-party extensions can conflict with Mobile Joomla!. In this case,
the following tips and tricks can be useful:

1. Try to disable the conflicting plugin/module using Mobile Joomla!’s
Extension Manager.

2. For system plugins you can try to reorder them to run conflict plugin
before or after Mobile Joomla!.

3. In mobile mode Mobile Joomla! creates ‘_MJ’ constant, so you can
add a check like

if␣(defined('_MJ'))␣{␣...␣}

inside any PHP file of any extension.

4. In the case of issues with displaying a component or module in
mobile templates it may be reasonable to make special “view” for
the extension in mobile template.
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To do this, you should copy each file from
components/com_[extname]/views/[view]/tmpl/[file].php
to
templates/[mobile_template]/html/com_[extname]/[view]/[file].php
for components, or from
modules/mod_[extname]/tmpl/[file].php
to
templates/[mobile_template]/html/mod_[extname]/[file].php
for modules.
Then, you can edit this files whatever you like, and Joomla! will
automatically use them.
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CHAPTER

6
Mobile Joomla!
Extensions

W ITH Mobile Joomla! Extensions, you can tailor your site to
perfection and ensure the best results on mobile. We will
see the core Mobile Joomla! extensions, and go through

all the pre-installed extensions. Then we will take a closer look at the
Kunena Mobile extension. We also discuss the JComments and Mobile
Ads extensions.

6.1 How to Install a Mobile Joomla! Extension
Installing a Mobile Joomla! extension is not much different from installing
a desktop Joomla! extension:

• Login to your site backend from the Administration panel.
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• Go to Extension Manager.

• Browse the correct extension file.

• Click Upload & Install.
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• If you see success message continue. Otherwise, please fix the error
or search/ask for help at the Mobile Joomla! forums.

• Go to Joomla! extension manager and find the extension.

• Enable the plugin.
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6.2 Overview of the Core Extensions
Next, let’s review on the core extensions of Mobile Joomla!:

6.2.1 Mobile Joomla! Plugin

This plugin must run first, and it is the main Mobile Joomla! component.
It recognizes the browser using other plugins. It decides which template is
required for a particular client browser and optionally changes Joomla!’s
homepage menu item. If this plugin is disabled then Mobile Joomla! is
turned off and will not work on the site.

6.2.2 Mobile – Simple Plugin

This plugin does exactly what the name hints: it recognizes the most
common browsers, but it may fail in some cases. Thus, it’s not the main
detection method used by Mobile Joomla!.

The plugin just checks for the “User-Agent” HTTP header for known
iPhones, iPods, iPads (if enabled in settings) and the i-mode headers to
detect iPhone and i-mode correspondingly. If this check fails, then the
plugin checks for the “Accept” header to check if the phone supports HTML
format. If that is the case, Smartphone mode will be used, otherwise WAP
mode. Unfortunately, this plugin cannot determine the screen resolution
correctly for some devices. Mobile – Simple plugin recognizes most of
modern tablets/smartphones, but it fails with some of ancient phones
and even (though to less extent) with some modern phones.
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6.2.3 Mobile – AMDD Plugin

This plugin uses the fast and compact Advanced Mobile Devices Database
(AMDD) maintained by the Mobile Joomla! team. It is targeted towards
those users who want a compact yet high-performing database, and/or
want to make sure they only have GPLv2-compatible files installed on
their server.

The AMDD plugin includes an advanced detection code for faster device
detections, and a device database that contains currently more than
13,500 browsers. The database is extremely streamlined with the size
being less than 3 Mb.

6.2.4 Mobile – Domain Plugin

This plugin detects the usage of mobile subdomains and changes the
template accordingly. There are no special parameters, all the settings
come from Global settings tab of Mobile Joomla! Settings page.

6.2.5 Mobile – Always Plugin

This plugin forces the use of the mobile template and is used for two
purposes:

1) to debug the mobile site with any browser or tool;

2) the site is developed to be used with certain type of mobile devices
only.

There is one only parameter in the plugin, Mobile markup, with the
following possible values: Auto (default), mobile, tablet. The description
of the device types was explained in the section 1.4 Device Types.

6.2.6 Proxy Position

Most likely your desktop template and Mobile Joomla!’s template have dif-
ferent module position names (e.g. desktop template would have “banner”,
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“header”, “sidebar”, “footer”, and Mobile Basic template has “mj_top”,
“mj_middle”, “mj_footer”, “mj_panel”). And if you like to display desktop
position in mobile template, use Proxy Position module. This module
renders a module position in the place where this module is published.
For example, you can publish this module in “mj_top” position and set
it to display “sidebar” position from desktop template. As a result, there
is no need to create a duplicate of desktop modules to display in mobile
template.

6.2.7 Proxy Module

This module works in a similar way to Proxy Position module, but displays
just one module only. It may be necessary if there is no reason to display
all desktop modules in mobile template, but few of them only.

6.2.8 Mobile Switcher

This module allows switching between desktop and mobile versions of
the site. Mobile Joomla! installs two instances of the module: first in
mj_footer position for mobile templates, and second in footer position for
desktop template (to switch back to mobile version). But unfortunately a
lot of templates have no footer position, so you should change it to one
of the existing positions.

6.2.9 Mobile Joomla! CPanel Icon Module & Plugin

This backend module is used for fast access to Mobile Joomla! Settings
page and to update Mobile Joomla! when the update is available. The
module is used in Joomla! 1.5, 1.6, and 1.7. In Joomla! 2.5 and 3.x a
native plugin (Quickicon – Mobile Joomla! CPanel Icon) is used instead.
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6.2.10 Mobile Templates

Mobile Joomla! includes Mobile_Basic template. But you can also use any
other mobile templates (including a responsive template) or create your
own unique one.

Tips: The installed templates are not usual Joomla! templates. They
may be run through Mobile Joomla! Plugin only. That is why you
cannot assign them to menu items (in this case you get “Incorrect
usage of Mobile Joomla!” message).

6.3 Additional Extensions
Now that we have seen the core extensions, let’s take a look at the
additional extensions of Mobile Joomla!.

6.3.1 YouTube Mobile

This plugin replaces YouTube movies with a thumb that links to watch
the movie on YouTube.

6.3.2 Mobile Content

Mobile Content plugin allows you to show different content for different
mobile devices. The plugin requires Mobile Joomla! component to be
installed.

There are two ways to use this plugin. The first one is very simple: you
just frame certain content with

{mobile}...{/mobile}

or

{desktop}...{/desktop}
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quasi-tags for mobile and desktop site versions correspondingly.

6.3.3 Kunena Mobile Joomla! Extension

Kunena is a premium extension that makes your favorite Joomla! forum
extension Kunena rock iPhone, Android, Windows Phone 7, and countless
other phones. We are proud to offer Kunena Mobile Joomla! Extension in
cooperation with the Kunena core team.

The Kunena Mobile Joomla! extension will turn your desktop web Kunena
forum into stylish and gorgeous mobile version. It enables the core forum
activities for a mobile user: you can view sections, categories, and posts;
read, post, and reply; view attachments. The extension is HTML5 and
CSS3 and is powered by jQuery Mobile and our Elegance Mobile Joomla!
template.

6.3.3.1 Highlights and Key Features

Let’s go through the key features of Kunena Mobile Joomla! extension:

• Kunena 1.7-3.x are supported.
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• Displays sections, categories, child categories, posts.
• Allows read, post, reply, attach files.
• Displays Attachments.
• iPhone App mode for the front page.
• HTML5, CSS3, SEO.
• Joomla! 1.5, 1.6, 1.7, 2.5, 3.x compatible.

The extension comes with a full year of priority support, documentation,
and continuous improvement. Kunena Mobile Joomla! Extension has been
designed and developed in cooperation with the Kunena core team. Your
each Kunena Mobile Extension purchase will support their development.

If you want to see how the extension looks like, just navigate to http://
www.mobilejoomla.com/ with your mobile phone and browse our fo-
rums.

6.3.4 JComments Mobile Joomla! Extension

Mobile Joomla! Extensions Directory also features JComments Mobile
Joomla! Extension. This premium extension will adapt JComments for
iPhone, Android, BlackBerry, and other smartphones.
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We have overcome many obstacles and challenges in developing the
extension, and we are proud of the outcome. The user interface is
designed and tailored from the ground up for the most typical mobile
use cases. You can read, write, reply with quote, like, dislike, and view
attachments in comments. All is HTML5 and CSS3 powered by jQuery
Mobile and our Elegance Mobile Joomla! template.

6.3.4.1 Highlights and Key Features:

You will find the key features of JComment Mobile Joomla! extension
below:

• JComments 2.3.x and further.
• Read, write, reply, reply with quote, like and dislike.
• Attachment support for mobile.
• Displays Attachments.
• iPhone App mode for full screen browsing.
• HTML5, CSS3, SEO.
• Joomla! 1.5, 1.6, 1.7, 2.5, 3.x compatible.
• Full compatibility with all Mobile Joomla! Extensions.
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The JComments mobile extension comes with a full year of priority
support, documentation, and product improvement updates.

If you want to see how the extension looks like, just navigate to http://
www.mobilejoomla.com/ with your mobile phone and browse to the
blog!

6.3.5 Google Analytics Mobile

Google Analytics Mobile provides analytics support for:

• Smartphones with JavaScript capabilities (iPhone, Android, Nokia
Series 60).

• Low-end phones without JavaScript support.

By default, JavaScript based tracking is used on the iPhone template and
non-JavaScript based tracking on other templates.
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6.3.5.1 Installation Instructions

Now let’s see the step-by-step instruction for Google Analytics Mobile
installation:

• Register at http://www.google.com/analytics. Make sure you get
mobile tracking code from analytics (in format MO-xxxxxx).

• Install the Google Analytics Mobile extension through Joomla! ex-
tension installer.

• Go to Extensions → Modules. Choose Google Analytics.
• Choose position: mj_footer2 (by default it’s the bottom position in

all mobile templates).
• Check that you choose to hide title of the module.
• Type your GA code in the field “Web Property ID” (of the form

UA-xxxxxxx-x or MO-xxxxxxx-x) on the right panel.
• Save.
• Make sure module is enabled and published.

6.3.6 Google Maps for Mobile

Google Maps Mobile extension improves compatibility of third party
Joomla! extensions for Google Maps on Elegance Mobile Joomla! tem-
plate, without configuration or changes to your existing content. No need
for any setup: You install, and it just works!

Google Maps Mobile Joomla! Extension is free for our Elegance Mobile
Joomla! template owners.
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CHAPTER

7
Mobile Joomla!
Pro

SO far, we have gone through the standard Mobile Joomla! features.
In this chapter, we will go through Mobile Joomla! Pro in detail.
We will cover the installation steps and configuration. Then, we

will review the features of Mobile Joomla! Pro. Finally, we will cover the
uninstallation steps.

7.1 Overview of the Features
Mobile Joomla! Pro includes advanced features for those who want more
and better performance: Remote device detection, Tablets support, Online
device simulator, Backup & restore and more.
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Advantages of Mobile Joomla! Pro:

• No more large database space needed: Remote Device Detec-
tion doesn’t require manual updates, and makes sure your mobile
website always supports the latest devices.

• Test your mobile website on the fly on latest devices with online
device simulator.

• Backup, restore and transfer your Mobile Joomla! Pro settings
and ease up your multi-site management process.

• Get faster page loads, reduce bandwidth usage, and offer smoother
user experience with your responsive template.

Next, let’s take a look at some specific Mobile Joomla! Pro features.

7.1.1 Remote Device Detection

If there’s one thing sure about the mobile market, it is that the rapid
change won’t slow down. Almost every day there are multiple new
devices launching in the market, meaning that you need to do constant
updates to your device database to make sure new mobile devices are
recognized correctly.

However, Mobile Joomla! Pro is aimed to make your life a lot easier, using
our own server based device detection that always has your back – so you
will have guaranteed support for all new devices with no more manual
device database updates!

With regular Mobile Joomla! releases, we also add newly introduced
devices to the device database. However, Remote Device Detection feature
coming with Mobile Joomla! Pro ensures that your mobile website will
always display seamlessly with every new device out there, as they are
introduced to the market. Also, you can reduce the size of your server
SQL database used to store handset data.
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Remote Device Detection is activated as you install Mobile Joomla! Pro.
Please note that, your server shall support remote device connections, in
order Remote Device Detection to work. You can see the status of Remote
Device Detection from Mobile Joomla! Pro backend.

When you Mobile Joomla! subscription is over, your Remote Device
Detection will expire. If you would like you mobile website to work on
latest mobile devices, without any need for updates, you can renew your
Mobile Joomla! Pro subscription.

If you do not renew your Mobile Joomla! Pro subscription, don’t worry,
in this case, our offline database will recognize mobile devices. However,
after some time, it will not be up-to-date, therefore we’d recommend you
to upgrade as soon as possible.

Please note that the Remote Device Detection has a limit of 200,000
detections/month currently, which should be well enough for most sites.
We have also options for those who need more, though – if that is the
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case, please contact us to discuss further. Should your traffic approach
the limit later on, we will contact you in advance.

7.1.2 Online Device Simulator

Testing mobile websites has always triggered many questions on our
forums. We’ve now implemented a tool that will make it a lot faster and
easier to tweak your site – with the mobile device simulators included in
the Mobile Joomla! Pro backend you can check how your changes affect
your site on the fly!

At the Mobile Joomla! Pro admin backend, you will see the Online Device
Simulator link in each device category. Just click on the Online Device
Simulator link to display your mobile website on given device.

Please note that despite the simulators should be quite accurate, since
they are by definition simulators and not real devices or emulators, there
may be slight differences between the view of the Online Device Simulator
and the real device.
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7.1.3 Tablet/iPad Support

Since tablets come with large screens and advanced browsers that can
display almost every website, Mobile Joomla! does not interfere when a
tablet visits your site. However, for those, who’d like to offer a complete
tablet experience for iPad and other tablet devices, Mobile Joomla! Pro
allows you to assign templates for visitors browsing your site with tablet
devices.

In order to activate your tablet template, go to “Tablet” tab at Mobile
Joomla! Pro admin interface. Select your tablet supported template from
the “Template” dropdown menu of “Settings” or “Tablet” section.

Please note that you’d ideally need a tablet supporting template, e.g. Ele-
gance Mobile Joomla! template, to display well on tablets.

126



7.1. Overview of the Features

7.1.4 HD/Retina Images

Retina display, sound familiar? Millions of devices come with advanced
screens that are capable of displaying high density and quality images.
Mobile Joomla! Pro enables delivers HD/Retina quality images for such
devices for the best user experience for your visitors.
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HD/Retina image support is enabled by default when you install Mobile
Joomla! Pro. If you’d like to disable it for some reason, you can do it at
“Image” section of “General” tab at Mobile Joomla! Pro admin interface.
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7.1.5 Backup & Restore Settings

With Mobile Joomla! Pro you can easily back up and restore your Mobile
Joomla! Pro settings. Great feature also for admins and web developers
who often have to migrate/copy their setup to use on different client
projects.

Mobile Joomla! Pro allows you to back up & restore your settings, so that
you can back up and restore your settings for the bad days, and at the
same time use your settings on different websites with ease.

Backing up and restoring your Mobile Joomla! Pro settings is easy. Just go
to “Backup & Restore” section under “Advanced” tab of Mobile Joomla! Pro
backend. Click to “Backup” link to back your settings up, or browse and
upload your previously backed up settings using “Browse” and “Restore”
buttons consequently from Restore section.

7.1.6 No Support Ads

As you know, Mobile Joomla! comes with Support Ads by default at the
bottom of each page. In Mobile Joomla! Pro you won’t get these ads by
default.

7.1.7 Premium Support

As a Mobile Joomla! Pro user you will get access to our premium Mobile
Joomla! Pro forum to make sure you get the best help for making your
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mobile website shine. For asking support, please follow our general
guidelines as listed in 2.10 Asking for Help.

7.1.8 Licensing

All Mobile Joomla! software products i.e. extensions, components, mod-
ules, plugins, templates, language files, documents are released under
the GNU/GPLv2 license when it comes to the PHP code portions of the
products. All images, CSS files, and included JavaScript elements are
released under the Mobile Joomla! Proprietary License, and they are NOT
GPL unless otherwise specified. For details, please read Mobile Joomla!
License Agreement.

Q: Do I need to purchase a Mobile Joomla! extension or template sepa-
rately for each domain?

A: Yes. You need a new license for the extension or template for each and
every website.

Q: Can I change the domain that my Mobile Joomla! extension or template
is registered for?

A: Unfortunately we don’t offer this option at the present time.

Q: Can I still use a Mobile Joomla! extension or template after my Sub-
scription expires? Do I have to pay more?

A: When your Subscription expires, you can still keep using the template
or extension you have downloaded during your Subscription period for
your registered domain without any extra fee. However, you will lose
access to downloads, updates, and premium support upon the expiry of
your Subscription.

For more questions and answers, please see the Mobile Joomla! Li-
censing FAQ: http://www.mobilejoomla.com/documentation/17-other/
90-licensing-faq.html.
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7.2 Installing and Setting Up
This section covers the installation and setup process of Mobile Joomla!
Pro.

7.2.1 Installation

Make sure you back up your site and Mobile Joomla! settings before in-
stalling Mobile Joomla! Pro for stability and security reasons. Installation
of Mobile Joomla! Pro is straight forward: Login to your administrator
backend and install component package as any other Joomla! component
or Mobile Joomla! extension.

7.2.2 Configuration

Mobile Joomla! Pro interface is identical to Mobile Joomla! interface,
except those additional features. You can access Mobile Joomla! Pro
backed from administrator backend or extensions menu.

7.3 Uninstalling Mobile Joomla! Pro
You can follow the normal Joomla! extension uninstallation process to
uninstall Mobile Joomla! from your system.

Tip: Note that the Mobile Joomla! settings will be lost if you unin-
stall it.

• First, we go to Extensions → Manage.

• Then click the “Manage”. And search for Mobile Joomla!. Then
click “Uninstall”.
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8
Closing Words

WE hope you enjoyed reading this guide!

We would be delighted to hear your feedback, so in case
you have any suggestions or comments related to this book

whatsoever, please let us know by email at �hello@mobilejoomla.com.
We would appreciate hearing from you!

We plan to update this book periodically with new features and tips. To
hear when we publish new updates, go and follow us on �Twitter and
� Facebook to stay informed. Often we publish some other interesting
information there, too.

Thank you for your support, and see you soon!

The Mobile Joomla! Team
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